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1 SI Image Installation 

The SI Image application provides for control of, and image acquisition from, Spectral 

Instruments’ cameras through a PCI card camera interface.  Operations provided include 

the ability to set camera operating parameters and image readout parameters as well as 

image acquisition, display, calibration and archiving functions. 

1.1 Computer Hardware Requirements 

The SI Image application runs under Windows 2000/XP.  Hardware requirements 

include: 

1) A Pentium or equivalent CPU 

2) 21 MB free space on the hard drive (8 MB for SI Image and 13 MB for the LabVIEW 

runtime engine) 

3) A CDROM drive 

4) A mouse with at least two buttons 

5) Adequate memory; memory requirements depend on the size of the CCD.  Since 

image buffers are single precision floating point for more accurate processing, 

memory requirements are high.  A minimum of 256 MB is required for a 1K x 1K 

device; 1 GB is recommended for a 4K x 4K CCD.  Memory requirements are lower 

if limited image processing is needed. 

6) One free PCI bus slot 

7) A graphics card and display that can support a resolution of at least 1024 x 768 at 

64K colors (2 MB graphics memory).  24 or 32 bit color is recommended for best 

image viewing. 

1.2 Installing the SI IMAGE Application Software 

The SI Image acquisition application is supplied on a CDROM that also contains the 

installation program.  If the CDROM does not auto-run, select Run from the start button 

and execute the Setup.exe file on the CDROM.  The installation program identifies the 

operating system, installs the correct files and makes the appropriate registry entries.  

There are five files on the CDROM that are specific to your type of camera and the CCD 

that is installed in it.  The xxx.bin file (where xxx is camera system specific) is the DSP 

code for the camera controller and is specific to the CCD sensor in the camera.  The 

2236.cfg file (see Appendix A) contains configuration information for starting the SI 

Image software.  The *.set file is camera head specific containing any special parameter 

settings for the camera.   It also contains the readout and format parameters for your 
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specific camera.  The *.map file (see Appendix B) is a map of the CCD defects which is 

used to correct the image if desired.  The xxx.cfg file provides name and information for 

the parameters of the camera that can be set or accessed and is associated with the DSP 

code (xxx.bin).  The xxx.bin file is CCD and camera type specific.  The CDROM also 

contains the plug and play drivers (Windows 2000, XP) for the PCI interface card.  

Following the software installation, leave the CDROM in the drive and turn off the 

computer.  Install the PCI card and restart the computer.  The plug and play should find 

the new card and the drivers on the CDROM and install them.  Note that you must have 

administrative privileges to install the driver.  The driver is able to support multiple 

PCI interface cards in the same computer.  The software can control one camera per 

instance of the software.  The file, SpecInst.ini, in the folder with the program instructs 

the software which PCI card to use.  This is a text-based file and comments within the file 

describe how to select the active card.  The default setting is for a single card. 

1.3 Arithmetic Models 

While an image is acquired as an unsigned 16-bit integer image from camera systems, it 

is converted to a single precision floating point (SGL) image within the program.  This 

involves converting from 2 bytes per pixel to 4 bytes per pixel, using twice as much 

memory but allowing much more precision and flexibility for image processing.  This is 

important when doing image subtraction where negative values can result and image 

averaging and flat-fielding where fractional values can be significant. 

It should be noted that 12-bit, 14-bit, and 16 bit CCD cameras physically saturate the 

analog processing systems at pixel values of 4095, 16383, and 65535 respectively. 

1.4 Uninstalling SI Image Software 

If the SI Image software ever needs to be uninstalled, use the Add/Remove Programs 

item in the Windows Control Panel. 

1.5 Hardware Check 

The camera uses a serial communications protocol to communicate between the camera 

interface, the PCI card, and the camera controller.  The driver sets the baud rate for the 

UART on the PCI card from a parameter supplied by the user in the *.set file.  This 

parameter value can range from 9600 to 250,000 depending on the camera.  See the 

camera hardware manual for selecting the baud rate when necessary.  As long as the 

default baud rate is used, there is no action to take relative to hardware operation except 

to turn on the camera power.   If the baud rate is ever changed on the controller, it is 

necessary that the hardware selection in the controller and the value in the *.set file agree. 
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2 SI Image Virtual Instrument 

The SI Image application uses the Virtual Instrument (VI) concept where the various 

buttons, knobs, dials, displays and controls that you would expect to find on an 

instrument are replaced by graphical equivalents that appear on the computer screen. The 

instrument hardware no longer has physical controls.  The combination of computer 

screen, keyboard, and mouse replace their function in ways that can be easily optimized 

for specific tasks. 

2.1 Starting the SI Image Application, Operate Menu 

This section gives a brief description of how to operate the camera.  More detailed 

explanations of the operation and functionality of the software are given in Section 3.  

During installation, a program Group is created.  The SI Image application can be started 

in the normal Windows fashion from the Start menu or from the icon in the program 

group. 

 

Figure 2.1  SI Image Front Panel 
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When the application is started, it loads the software 

configuration file, 2236.cfg, (see Appendix A on page 

75) that specifies program specific items.  All camera 

specific information is in the settings file (*.set where * is 

usually the camera serial number).  If there is more than 

one settings file in the folder with the main SI Image 

program, a dialog box will open to ask the user to select 

the desired file.  This is useful if more that one camera is 

being used with the same computer or if settings files 

have been created for specific camera configurations.  

The default values should be OK to run the camera.  

Changing these configuration values is discussed in 

Section 3. 

Prior to initialization of the camera, any functions that require communication with the 

camera are disabled and the associated buttons on the panel are “grayed out”.  This 

allows the application to be run on archived files without a camera attached. 

Selecting the Initialize 

item in the Operate menu 

initializes the camera, which 

sends the file *.bin to the 

controller. In some newer 600 

Series and 800 Series and 

higher cameras, the DSP code 

is stored in an EEPROM in 

the camera head so it is not 

necessary to send it to the 

camera during initialization.  

After camera initialization, 

the controller either opens 

and closes the shutter once 

(Series 500), briefly sounds 

the alarm (Series 600), or 

flashes the power LED three 

times (Series 800 and higher) 

to indicate successful 

initialization.  If this does not 

occur, the camera has not 

been properly initialized and 

will not operate.  Error 

messages appear if the 

camera power is not on, a 

cable is disconnected, or the 

wrong baud rate setting was 

selected.  Follow the 

instructions in the error 

 

Figure 2.2  Initialize Selection 

 

Figure 2.3  CCD Settings Panel 
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message to correct the condition.  If a CryoTiger cooled 600 or 1100 series camera is re-

initialized once the cooling has started, the CryoTiger will be turned off and there will be 

a short delay before it restarts. 

The window for the SI Camera CCD Settings is displayed automatically (Figure 2.3) 

after the camera is initialized.  This window allows setting various operational parameters 

of the camera.  CCD Format Parameters On the Camera Settings tab specify the 

origin, size, and binning of a subarray to be read and are changed frequently for image 

acquisition.  The Readout & Format tab provides access to all of the options available 

for routine user control of the camera.  The Configuration tab parameters specify all of 

the settings for camera parameters that are established during the fabrication and testing. 

These are not intended to be changed during normal use but the capability is provided.  

To begin with, the default parameters are probably fine and the  button can be 

pressed so that an image can be acquired.  Details of the CCD 

Settings are covered later.  

Once the camera settings are established, image acquisition and 

display may proceed.  Two image buffers are allocated in the 

program, Image 1 and Image 2.  Images can be acquired into 

either buffer by pressing  or .  

Each button is associated with a “type” selector (see Figure 2.4) 

located immediately to its right.  The selector offers a choice of 

Light Exposure, Dark Exposure or Test Image (depending on the camera, other options 

may be available).  After setting the desired exposure time, pressing either of the 

Acquire buttons proceeds to operate the camera to obtain an image of the type 

indicated into the buffer selected.  Once an image is in a buffer, the display of that image 

can be modified using any of the provided tools. The Display control, , 

indicates the image buffer being displayed and is also used to select the image buffer to 

display.  When a new image is acquired, the Display control is automatically set so that 

the new image is displayed on the screen.  

It is important to note that the new image may not be the same size as the image area 

shown currently in the visible display.  The Ctrl+F keyboard shortcut or hotkey resizes 

the visible display to show the entire image.  This is set to automatically happen upon the 

first image acquired after opening the SI Camera CCD Settings  window or selecting a 

region of interest (ROI will be discussed later).   Depending upon the user-controlled size 

of the Front Panel (Figure 2.1), the display may represent square image pixels as 

rectangles.  Pressing Ctrl+P redraws the display with proper pixel aspect ratio although 

this may result in some portion of the display panel being unused and shown in gray. 

2.2 Image Display Tools 

Several tools are provided which affect the image display by changing the gray scale 

mapping, zooming, panning and contrast.  These tools are accessed by on-screen controls 

 

Figure 2.4  Image 

Type Selector 
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(buttons, sliders and indicators). Other tools in the View menu are used for examining 

the image. 

2.2.1 Cursor Display 

The two cursors in the image display 

can be used to read pixel values from 

the image, to control the viewing of 

a row/column plot and to specify a region of interest.  Figure 2.5 shows the cursor display 

on the front panel.  Three numeric indicators are associated with each cursor.  For the 

blue cursor (Cur 1) above, X position is 1021, Y position is 1023, and the value of that 

pixel is 5820.8.   Though this manual is in monochrome, the cursor, Cur 0, is red and the 

cursor, Cur 1, is blue on the screen.  The group of four diamonds, to the right of the 

cursor display, provides one method of moving the cursors in the image display.  The 

four diamonds are buttons that move the selected cursor (in Figure 2.5, Cur 0 is the 

selected cursor, indicated by the green dot in the button to the right of the pixel value, 

) by one pixel in the chosen direction.  Both cursors may be selected as being active at 

once and, if both are active, they are moved together by the arrow buttons.  The cursor is 

selected either by clicking on the cursor in the image display or clicking on the selection 

button, , for the desired cursor. 

To the right of the cursor selection button is a control, , that allows setting the cursor 

attributes including the color and style of the cursor.  The cursor attributes can be 

modified as shown in Figure 2.6.  With 

this control, the Color, Cursor 

Style, Point Style, Line Style, 

and Line Width can be changed.  

The Show Name option displays the 

cursor name (Cur 0 or Cur 1) next to 

the cursor in the image display.  Any 

settings modified here continue until 

the program is restarted at which time 

the attributes revert to the initial 

defaults.  Bring to Center positions 

the selected cursor in the center of the display.  This is not used often since the cursor 

positions are monitored such that they are always in the viewed area even after zooming.  

To the right of the cursor attributes is a control, , that locks the cursor to the lower left 

corner of the pixel (if 0,0 is the lower left of the image display).  When the control is 

clicked, the cursor is unlocked, , and the cursor is able to move within a pixel and the 

X-Y readouts display fractional values.  The cursors can also be moved in the image 

display, using the mouse, by dragging the selected cursor.  The indicators in the cursor 

display are automatically updated as either cursor is moved.  Since the mouse is also used 

for zooming in the display, the cursor mode, , must be selected in the image display 

palette, discussed in the next section. 

 

Figure 2.5  Cursor Display 

 

Figure 2.6  Cursor Attributes Control 
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2.2.2 Image Display Palette 

On either side of the cursor movement diamond are the 

image display palette components shown in Figure 2.7, 

the scale palette (left) and the graph palette (right).  On 

the scale palette are axis scale lock buttons, , that, 

when clicked-on, lock the autoscale on for the X or Y-

axis of the display.  In this mode, , when a new 

image is displayed, the selected axis will auto scale.  

When unlocked, , the axis will not autoscale when the image display is updated.  The 

 and  buttons are autoscale buttons for each axis.  These can be used to autoscale a 

single time to restore the full image on the selected axis after a zoom has been performed.  

The next set of buttons to the right,  and , allow the format and precision of the 

axis labels to be modified.  The graph palette controls how the mouse interacts with the 

image display.  When a graph palette button is selected, its color darkens and a green 

LED is illuminated in the upper left corner of the button.  The  button on the left of the 

palette is the cursor select button that puts the image pointer in cursor mode when it is in 

the image display.  This mode allows the user to move the image cursors by dragging 

them around the image display.  The other two modes of the image pointer are zoom and 

pan.  The zoom tool, , is shown expanded in 

Figure 2.8.  The tools include a zoom box , X-

axis zoom , Y-axis zoom , undo zoom , 

zoom in , and zoom out .  The appearance of 

the image pointer in the image display area changes 

depending on which zoom tool is selected.  Some of 

these buttons also have hotkey shortcuts that can be 

convenient for mode switching.  They are: Home - 

, Page Up - , End - , Page Down - , F11 -  and F12 - . 

Zooming can also be performed by directly editing the minimum and maximum values of 

the X and Y-axes on the image display.  In addition, typing the minimum value into the 

maximum on an axis reverses that axis.  For instance, if the X-axis is 0-1024 and you 

directly edit the maximum value of 1024 and make it 0, the axis flips and makes 1024 be 

on the left and 0 on the right. This can be useful to make an image direct reading, to 

display text properly for instance.  A selection is also provided on the View menu to 

allow the X- and Y-axes to be reversed. 

The final button in the palette is the pan button , which allows the displayed area to be 

moved about by pressing and dragging the mouse in the display area.  Note that the 

appearance of the image pointer in the image display changes to look like the selection 

button depending on the mode chosen.   

  

Figure 2.7  Image Display 

Palette 

 

Figure 2.8  Image Zoom Palette 
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2.2.3 Z Axis Scaling 

The  button scales the Z-axis gray scale or color scale of the image.  The hotkey 

F9 also performs this function.  When the button is blue, it has been set to autoscale 

mode where the Z-axis is automatically scaled whenever a new image is displayed.  

When autoscale is off, the button is gray.  This is controlled in the View menu discussed 

in the next section. The range of the scale is determined from a histogram of all of the 

pixels in the image currently displayed. The histogram is clipped from the ends by the 

amount selected using the %Hist control just below the  button.   Five 

different selections are available.  These are 10%, 5%, 3%, 1%, 0.5% and 

0.1% of the pixels.  Selection is made by clicking the up or down arrows or by 

clicking in the numeric display window, which provides access to the range of 

options available.  As shown, the current selection is checked indicating 3% 

but the new selection will be 0.5% as indicated by the highlight.  Pixels are 

discarded equally from each end of the histogram until the percentage selected 

has been eliminated.  This allows a selectable percentage of the pixels to 

be ignored in computing the minimum and maximum for the image 

display avoiding dark and bright artifacts affecting the scaling.  The 

slider is then formatted to indicate the range of pixels to be used in 

displaying the image.  

The Z-axis scaling can also be modified using the slider controls.  In 

addition, when this is performed, the Z-axis slider, Figure 2.9, is scaled 

with a range slightly larger than the specified limits.  The two-slider 

controls can be used to change the minimum and maximum of the image 

display using the mouse, thereby changing the contrast of the display.  

When one of the sliders hits its limit, the limit is automatically changed 

to enable further scaling in that direction.  The selected slider, the 

bottom slider in Figure 2.9, is the last one that the mouse clicked on.  

The selected slider is slightly enlarged. 

The upper and lower display limits can be edited manually by clicking 

on the number to be edited to set the limits of the slider display.  Note 

that this does not change the appearance of the image displayed, it 

merely changes the slider display and subsequently the slider(s) can be 

moved into the new range to change the appearance of the image. 

The  button scales the image using the pixels within the box 

formed by the red cursor and the red offset cursor that define the 

statistics  region (see section 3.5). 

 

 

Figure 2.9  Z 

Axis Slider 

Control 
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2.3 View Menu 

Two sets of terminology are used 

in this manual when attributes of 

the image display are discussed.  

The display utilizes a standard 

graphics Cartesian coordinate 

system and some items are 

specified by X- and Y- values.  

The image is composed of rows 

(displayed vertically) and columns 

(displayed horizontally).  The 

image is read out from the sensor 

one row at a time.  The first row is 

located at X-coordinate 0.  The 

first pixel of the each row is 

located at Y-coordinate 0.  The 

length of a row is the serial 

dimension as set in the CCD 

Settings.  The length of a column is 

the parallel dimension as set in the 

CCD Settings.  The last pixel in each row is displayed at the maximum Y, and the last 

pixel in each column is displayed at the maximum X coordinate of the image display 

palette.  X and Y coordinates on the image display can be reversed, by selections 

discussed later, so there is no intrinsic left or bottom associations between image display 

and coordinate value 0. 

Additional image display tools are provided in the View pull-down menu at the top of 

the front panel window.  This menu operates like a standard Windows menu (Figure 

2.10). 

2.3.1 Region Of Interest 

The first item on the View Menu is the Set ROI which allows selection of the current 

region of interest (ROI).  A ROI is defined as the area within the two image cursors. The 

red and blue cursors, positioned arbitrarily within the image, delineate an area to readout 

from the camera when a new ROI is selected.  To select a ROI at the current cursor 

position, type Ctrl+F1 or select the Set ROI menu option.  When a ROI is selected the 

first time (you can also select a new ROI when viewing a previously selected ROI), the 

current displayed readout format becomes the reference readout format.  After a ROI is 

selected, the next image acquisition will acquire the ROI.  After obtaining an image of 

the ROI, the reference format can be quickly re-established by Ctrl+F2 or by the Reset 

Image Format menu option. 

 

Figure 2.10  View Menu 
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2.3.2 Zoom Windows 

The next item on the menu is Zoom Windows which 

provides floating windows that display a magnified view of 

the image.  When this item is selected, two new windows 

pop up.  One is the View Zoom Wins control panel,  

Figure 2.11, and the other is the zoomed image display, 

Figure 2.12.  The zoomed image display has the View # 

and the cursor coordinates in the title bar.  The view is tied 

to the red cursor in the image display and is centered on the 

cursor, Figure 2.13.   

The zoomed image window is resizable and floating so that 

it can be moved so as not to obstruct the main image.  

When the zoomed window is made larger, the 

magnification remains the same and it shows more of the 

image.  The View Zoom Wins window is also moveable 

and expandable using the  button.  Before 

adding a second zoom window, normally the previous 

window will be locked to the current cursor position by 

pressing the  button associated with the window 

View # 1.  The button will change to  indicating that 

it will no longer follow the cursor but stay at the current 

image coordinates.   

 

When a zoom view is added, the View Zoom Wins 

window expands to show View # 2 with its associated 

buttons.  The Z Scale buttons can be  or .  In 

auto-scale mode, the zoomed window will scale to the 

minimum and maximum pixel values automatically as the 

cursor is moved or the image is changed.   The Color Scale 

button allows the image to be changed from gray scale to a 

false color scale that provides a larger visual dynamic 

range.  Initially the magnification in the Y (vertical) 

direction is locked to the magnification in the X 

(horizontal) direction and the  Y Mag control is disabled.  

When the X Mag is changed the Y Mag changes as well 

to maintain the correct perspective.  By un-checking the 

Lock to X control, the magnifications can be varied 

separately.  Multiple locked zoom windows can be useful 

for focusing where several places in an image need to be 

monitored in detail. 

  
 

 

Figure 2.11  Zoom 

Window Control Panel 

 

Figure 2.12  Zoomed Image 

Display 

 

Figure 2.13  Cursor in Image 
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2.3.3 Turn On Row/Column Plot 

The next item on the menu is Turn On Row/Column Plot and is accessed by the 

hot key Ctrl+R.  This function opens a floating window (Figure 2.14) containing a graph 

that shows plots of a single row or column, the average of rows or columns, or an 

arbitrary line in the image between the two cursors. 

Single line plots or averaged plots are selected through the 

control shown in Figure 2.15.  Single-row or single-column 

plots show the pixels located at the position of the red cursor 

(Cur 0) in the image display.  Averaged plots show the 

average of the pixels between the red and blue cursors.  The 

arbitrary line plot shows the intensity data along an arbitrary 

line between the two cursor in the image. As a cursor is 

moved in the image display, the line data shown in the 

Row/Column Plot window is updated automatically.  The 

plot window floats and is always on top of the Front Panel so 

that it can be moved allowing simultaneous viewing of the plot region in the image.  The 

plot window has cursor controls, indicators, and zoom controls similar to those provided 

with the image cursors as discussed above. Some of these palette buttons also have 

hotkey shortcuts that can be convenient for mode switching.  They are: Home - , Page 

Up - , End - , Page Down - , F11 -  and F12 - .  Note that the scale 

Y-axis  is set for autoscale in Figure 2.14.  

The selector, shown as Averaged Columns in Figure 2.14, is used to select the row, 

column, average of rows or average of columns, or an arbitrary line from the image 

display.  The indicator below the plot type selector shows the number (or the range) of 

 

Figure 2.14  Row/Column Plot 

 

Figure 2.15  Plot Type 

Selector 
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the row(s) or column(s) being displayed.  The  button locks the X-axis of the 

graph display to the length of the selected row or column from the image display.  When 

the X-axis lock is off and the X-axis is zoomed in on as in Figure 2.14, the scroll bar 

beneath the plot will pan the plot along the X-axis.   Pressing the  button prints 

the selected plot to the Windows printer.  The  button allows the line plot to be 

saved to a CSV (comma separated value) text file that is easily read by analysis or 

spreadsheet programs.  The  button closes the Row/Column window. 

2.3.4 Video Frames 

The Video Frames item on the menu provides 

for playback of high-speed acquisitions where 

multiple frames are contained in a single image 

file.  This type of acquisition is available only on 

certain camera models.  Images collected in 

“video” mode essentially contain multiple frames 

in a single image file and each frame is viewed 

by changing the X axis scale range since the 

frames are side-by side along the X axis of the 

image display.  The Frame control displays 

which frame is being viewed and can be used to 

jump to a particular frame in the sequence.  The 

bar scale also indicates the frame being viewed 

and can be utilized to jump to a particular frame 

using the mouse to move its position indicator.  

The Time (s) indicator (the (s) indicates seconds) 

displays the actual time in the sequence and is dependent on the value of the Acquisition 

Frames/Sec control that is set by the user.  The Playback Frames/Sec control allows the 

speed of the playback to be changed.  To initiate playback, press the  button and the 

playback starts in the forward direction.  The button will change to  during playback 

indicating that pressing it will pause the playback.  The  button plays in reverse.  The 

middle button, , selects single or continuous play.  The default is single where the 

play will stop at the last frame.  When in continuous mode, , after the last frame, the 

sequence will start again at the beginning when viewing in the forward direction.  The 

other two buttons,  and , cause a single frame step in the indicated direction. 

2.3.5 Show Image Scroll Bar 

This option turns on/off a horizontal scroll bar at the bottom of the image display that 

allows a zoomed in image to be scrolled in the horizontal direction.  The default is off. 

 

Figure 2.16  Video control window for 

playback of multi-frame images. 
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2.3.6 Histograms 

Stats Box Histogram and Full Image Histogram provide two options for 

generating a histogram of image pixel data.  Either the region that defines the stats box or 

the entire image is used depending upon the selection made (see section 3.5 for a 

description of the "stats box").  Selecting either option brings up a second floating 

window, shown in Figure 2.17, that has all of the same graphical controls as the plot 

window.  The cursors are usually left in locked mode so that the value of the histogram is 

updated in the cursor display as the cursor is moved.  The shortcut keys for the cursor 

palette functions are the same as in the Row/Column Plot window.  Hotkey Ctrl+B 

activates the stats box histogram while Ctrl+A brings up the full image histogram.  Since 

the image is in floating point representation (SGL), the range of values could be very 

large for a histogram especially after an image divide.  To prevent the size of the 

histogram from being exceedingly large, the histogram is clipped to its significant portion 

when the difference between the maximum and minimum far exceeds 2,000,000.  If  the 

histogram has been clipped, a red LED is displayed in the lower corner, either right or left 

depending on which end is clipped.  The scroll bar below the plot can be used to pan the 

X-axis when the user zooms in on the X-axis.  There is also a tool for calculating the 

population or number of pixels in the histogram between two values. 

2.3.7 Display Axes 

Flip X Axis and Flip Y Axis are mode selectors, which upon selection, show a � to 

indicate the status and also perform the image reversal on the displayed image.  Only the 

display is reversed.  The image data is not held in reversed format and all math and file 

manipulation activities will operate on the original format image.  Subsequent images are 

displayed in the selected mode.  The hotkey for toggling Flip X Axis is Ctrl+F10 and 

for Flip Y Axis, Ctrl+F11.  

 

Figure 2.17  Histogram Plot 
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2.3.8 Image Scaling 

The Auto Z Scale menu item turns on or off the auto Z scale function.  When 

activated, there is a � next to the menu item and every time a new image is displayed the 

 button, discussed above, is automatically pressed.  The color of the button is blue 

when in auto mode and gray when in manual mode.  The default and most common mode 

of operation for the SI Image acquisition program is autoscale.  The hotkey for toggling 

Auto Z Scale is Ctrl+F9. 

The Full Image menu item is useful to return the image display to the full image after 

zooming in to a region.  It can be activated in the menu or by hotkeys of Ctrl+F or F8. 

The Correct Perspective menu item scales the X and Y-axis so that the pixels in the 

display are square.  This is useful when using the zoom tools where it is easy to distort 

the display perspective.  This function is activated in the menu or by the Ctrl+P hotkey.  

There is also a Auto Correct Perspective menu item that will perform a correct 

perspective when Full Image is selected and whenever the ROI or acquisition mode is 

changed. 

The next three items, Color Scale, Gray Scale, and Non-Linear Gray Scale, select 

whether the display is shown in false 

color scale, gray scale or a non-linear 

gray scale.  The false color scale 

allows a greater visual dynamic range, 

which can be useful in some imaging 

applications.  The non-linear gray 

scale also is useful for images with 

large dynamic ranges to visualize 

lighter or darker areas of the image.  

When Non-Linear Gray Scale is 

selected, a window pops up (Figure 

2.18) to enable adjusting of the non-

linear scaling.  The window shows the 

histogram of the image at the top and 

has three controls that can be used to 

adjust the image scaling.  The blue line 

on the left and the red line on the right 

can be moved with the mouse to set 

the minimum and maximum for the 

image Z scale.  The green cursor, , 

allows the curvature of the non-linear 

scaling to be adjusted. 

Selecting one of the options automatically de-selects the other.  The current mode 

selected is indicated by a check. The hotkey for toggling Color Scale is Ctrl+Shift+C. 

for Gray Scale, Ctrl+Shift+G and for Non-Linear Grtay Scale, Ctrl+Shift+N.  

 

Figure 2.18  Non-Linear Gray Scale Window 
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2.4 File, Edit, Window and Help Menus 

The File, Edit, Window and Help menus 

contain items similar to a normal Windows program 

with a few differences. 

2.4.1 File Menu 

The File menu, (Figure 2.19), as in most Windows 

programs, allows the user to open and save files, 

perform page setup and printing, and exit the 

program.  The open and save functions operate on 

the image buffer that is being displayed.  The 

normal Windows dialogs are used for file selection 

in the Open Image (also accessed by Ctrl+O or 

F5) and Page Setup functions.  The Open 

Image function automatically determines the file 

type, FITS or TIFF, and opens the file. 

The Save Image function (also accessed by 

Ctrl+S or F6) has an additional window (Figure 2.20) so that the file information can be 

 

Figure 2.19  File menu 

 

Figure 2.20  Image Information window 
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viewed and modified before saving.  The file 

name can be entered at this time, or when 

the path is selected in the Windows dialog 

that is opened when the information window 

is closed.  The time and date stamps are 

automatically entered when the image is 

acquired and are not changeable.  The 

comment field allows a variable length 

comment to be saved with the image file. 

The Save As control (Figure 2.21) allows 

selection of the file format in which to save 

the image.  The default format is SGL FITS.  

Other formats, either FITS or TIFF, are 

provided for compatibility with other 

programs.  The 16 bit formats (U16 – unsigned 16 bit integer, I16 – signed 16 bit integer) 

will of course be half the size of the 32 bit formats (SGL – floating point single precision, 

I32 – signed 32 bit integer).   SGL format is recommended so that no information is lost 

due to clipping or rounding required when using integer formats.  The Scaled U8 TIFF 

format is a special case where an 8-bit TIFF image is saved scaled as viewed in the image 

display.  This is useful when images need to be placed into a document.  

The Image Transform controls (Figure 2.22) allow the image to be transformed before it 

is saved.  This is useful when the image will be read by another program that is expecting 

the orientation of the image to be different than the default orientation.  Up to two 

transformations can be applied to the saved image.  The rotations are 90° to the left or 

right.   

The Status & Parameters indicator (Figure 2.20) 

displays tabs for the  Camera Status, Readout & 

Format parameters and Configuration parameters.  

There may also be a tab for Other parameters if the 

user takes advantage of this feature (see Appendix 

C).  The status and parameters are entered 

automatically when the image is acquired and are 

not editable.  The tables have three columns, Name, 

Value, and Units / (Converted).  The value will 

always be numeric and the Units / (Converted) 

column will show the Units if they apply or a text of 

what that value means in parentheses.  In Figure 2.20, Cooler Status has a value of 1 

which is “converted” to (On).  In the case of the Readout & Format parameter DSI 

Sample Time, a value of 20 could correspond to (800 KHz) readout speed (see Figure 

2.23).  If Other parameters are used from the text file described in Appendix C, the third 

column becomes Comment. 

 

 

 

 

Figure 2.21  Save As control 

 

Figure 2.22  Image Transform 

control 
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The  button saves 

the changes and closes the 

window.  When saving an image, a 

Windows dialog opens for 

selecting a path and optionally 

changing the file name.  The 

 button cancels 

any changes made to the 

information and closes the 

window.  When saving an image, 

this action aborts the saving to 

disk.  The  button 

provides a printout of the image 

information on the selected printer. 

The Display Image 

Information menu item opens 

the same window used for Save 

Image (Figure 2.20) without the Save As and Image Transform controls.  This can be 

used to view the image information and edit the file name and the comment. 

The Auto Save item turns on/off the 

auto save feature where images are 

automatically saved after they are 

acquired.  When the item is initially 

selected, a window is opened (Figure 

2.24) where the file name, folder and 

number in the series to start with are 

selected.  When a new image is 

acquired, the file is saved and the 

counter in the file name is 

incremented.  In the example in Figure 

2.24, the first image would be “Test 

Images 0001.fit” and next would be 

“Test Images 0002.fit” etc.   

Any automatic corrections selected 

(see Section 4.2) will be applied before 

the image file is saved.  When Auto 

Save is selected, a � appears next to 

the menu item in the File menu and the 

Acquire Image buttons change from 

gray to blue.  

 

Figure 2.23  Readout & Format parameters tab in 

Image Information window. 

 

Figure 2.24  Auto Save setup window 



   

18 

The View Error Log item opens a window with a log of any errors that have occurred 

since the program started.  There are options to Print, Save to a file and Clear the log. 

The View Multiple Images 

menu item allows viewing 

multiple image files with a set 

time delay between successive 

images.  Optionally, the region 

statistics that are displayed in 

the lower right corner of the 

main window can be logged to 

a disk in a comma-separated 

values (CSV) file for importing 

into an Excel spreadsheet.  

Following the optional log file 

selection, a window opens 

(Figure 2.25) where the image 

files for viewing are selected.  

The files are selected in the top 

of the window either by double 

clicking on them or by 

selecting and pressing the 

 button.  Multiple files 

can be selected by holding the 

Shift key while clicking on the 

filename, then pressing the 

 button.  Once the 

files have been selected, press 

 to begin viewing.   

The first file is opened and a control window opens, 

Figure 2.26, to control the playback of the image 

files.  To initiate playback, press the  button and 

the playback starts in the forward direction.  The 

button will change to  during playback 

indicating that pressing it will pause the playback.  

The  button plays in reverse.  The middle 

button, , selects single or continuous play, .  

The default is single where the play will stop at the 

last frame.  When in continuous mode, after the last 

frame, the sequence starts again at the beginning 

when viewing in the forward direction.  The other 

 

Figure 2.25  Select multiple images for viewing. 

 

Figure 2.26  View Multiple Images control 

window 
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two buttons,  and , cause a single image step in the indicated direction. 

The Delay (s) control ((s) is seconds) sets the time to delay before opening the next 

image.  To jump to a particular image in the series, enter a number into the Image control 

or the mouse can be used to move the indicator on the bar scale.  The file name of the 

image being opened/viewed is displayed on the Image Name indicator. 

The View Multi-Frame Images menu item is used to view multi-frame images that 

some cameras are capable of taking.  A multi-frame image is a special type of image 

acquisition where the camera acquires several images or frames with a single command 

and saves them to a multi-frame image file (see Section 3.6.3 for a full description).  The 

full multi-frame image is often too large to load into memory as a single image.  This 

function allows the image to be loaded one frame at a time and displays a control window 

similar to the View Multiple Images control in Figure 2.26 for flexible viewing of the 

image frames.  If the entire multi-frame image is of a size such that it can be loaded into 

memory at once, the Video Frames item in the View menu (see Section 2.3.4) can be 

used. 

The Set File Filter menu item allows a filter to be applied to the file names that are 

displayed when opening an image.  For example, a filter of “Test Series 1*.fit” will only 

show image files that are FITS files and their names begin with “Test Series 1”.  The “?” 

character can also be used as a single ‘wildcard’ character. 

Print Image will print the image along with the filename, comment, date, and time of the 

acquisition and the region statistics for the current cursor setting. 

2.4.2 Edit Menu 

The Edit menu provides the standard Windows edit 

functions (Figure 2.27).  These can be used when editing 

text or values in controls. 

 

 

2.4.3 Window Menu 

The Window menu (Figure 2.28) 

allows the user to view information 

about the program.  Items of 

interest in the Info window are the 

program file path and the memory 

usage of the program. 

 

Figure 2.27  Edit Menu 

 

Figure 2.28  Windows Menu 
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2.4.4 Help Menu 

The Help menu (Figure 

2.29) contains two items.  

The About item, as in most 

Windows programs, 

displays information about 

the program.  This includes 

the revision information for 

the program, the DSP code, 

the DLL and driver for the PCI interface 

card, and the version of Windows that the 

program is installed for.    The Show Help 

(also accessed by Ctrl+H) opens a floating 

window that provides information about the 

item on the front panel of the program that 

the mouse is over.  Figure 2.30 shows the 

help window when the mouse is over the 

image display on the front panel.  This Help 

Tool is useful for determining the function of 

indicators or buttons on the front panel.  If a 

button can be operated with a function key, 

such as F1 for the  button, 

it is indicated in the Help window. 

 

 

 

Figure 2.29  Help Menu 

 

Figure 2.30  Show Help Window 
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3 SI Image - Controlling the Camera 

While the last sections covered initial startup and acquiring an image along with general 

operation of the Virtual Instrument, this section covers the camera control functions and 

image acquisition features of the software in more detail.  Figure 3.1 is the same front 

panel shown in Figure 2.1 except that a few additional “LED” indicators, and a TCP/IP 

button are shown.  These LEDs, described in detail later in this section, indicate 

automatic corrections to be performed, whether files for corrections have been set, and 

whether the camera’s temperature or pressure are out of a normal range. 

 

Figure 3.1  SI Image Front Panel 
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3.1 Operate Menu 

The Operate menu, Figure 3.2, contains 

items concerning the operation of the 

software and the camera. 

3.1.1 Initialize 

When the program is started and the camera 

is powered up, the first operation is to 

initialize the camera.  Initialization is 

different depending on the camera.  All 800 

Series and above and some newer 600 Series 

with a fiber-optic interface, have the DSP 

code stored in an EEPROM in the camera 

head.  These cameras are ready to 

communicate as soon as they are powered up.  500 Series and most 600 Series cameras 

need to have the DSP code downloaded to the camera before the camera can start normal 

communications.  The initialization process determines if the camera needs to have the 

DSP code downloaded and does so if necessary.  The SI Camera CCD Settings window 

(discussed in detail in Section 3.2) is automatically opened following initialization.  

3.1.2 Select Camera 

The Select Camera item opens a 

window (see Figure 3.3) allowing 

a settings file to be selected that 

contains the camera-specific 

information for the camera being 

used.  This allows different 

cameras to be operated on the 

same computer in a convenient 

way.  The settings filename is 

usually the serial number of the 

camera followed by ‘.set’, such as 

600-107.set.  The  button 

closes the window without 

changing the current settings file.  

This window is displayed when 

the program first starts if there is 

more than one *.set file in the 

folder with the main SI Image 

SGL program.  

 

Figure 3.2  Operate Menu 

 

Figure 3.3  Select Camera window 
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3.1.3  Configure 

The controls in the 

Configure window are used 

to set the software and 

camera configuration 

parameters that are saved in 

the 2236.cfg file (program 

specific items, see Appendix 

A) and settings file (camera 

specific items, the filename 

is ‘serial number.set’ or 

*.set ) that are installed with 

the program.  Both of these 

files are text based and can 

be edited with a text editor.  

The configuration window 

is provided to conveniently edit the more common items the user may need to change.   

The default baud rate is fine for most all camera systems.  If a different baud rate is set in 

the camera controller, the value in the software configuration must be changed.  The 

Baud Rate control is a pull down selector that allows only the certain baud rates (see the 

Camera User Manual for baud rates supported).   

The DSP Code File specifies the filename of the DSP code.  This is not normally 

changed but is useful if custom DSP code is used to implement special camera functions.  

If new DSP code needs to be downloaded to the camera, refer to DSP Utilities in Section 

3.1.6. 

The Default Settings File selects the *.set filename that is initially read when the camera 

is initialized and contains the readout and format parameters discussed below in Section 

3.2.  This is also the file where the DSP code filename and the baud rate are saved since 

they are camera specific.  

When the Save Current Main Window Size and Position check box is checked, that 

information will be saved in the 2236.cfg file so that the main program window will 

resume the current window size and position the next time the program is started.   

The Default Image Path sets the starting path for opening and saving image files.  The 

path can be entered directly or selected by pressing the  button and browsing disk 

folders.  Browse to the desired folder and press the  button in the browse 

window. 

The Default Save Image As control selects the default image type appearing in the Save 

As control when saving an image.  Image types are FITS or TIFF in unsigned 16 bit 

 

Figure 3.4  Software Configuration Window 
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(U16), signed 16 bit (I16), signed 32 bit (I32), single precision floating point (SGL) and 

scaled unsigned 8 bit TIFF (Scaled U8 TIFF). 

The Delay to Alert after Image Acquisition sets a time delay after an image is acquired 

before an acquisition complete alert is displayed.  The alert will only appear if there has 

been no user interaction with the program during the delay time. 

The Error Window Timeout allows the user to set a timeout on pop up error windows if 

desired.  A value of -1 will cause the error window to stay open until the user closes it.  If 

the timeout is set to automatically close the error window, the errors can be viewed using 

the View Error Log item in the File menu. 

The SI Image program is set to automatically poll the camera for its temperature and 

pressure at a set time interval (see Section 3.1.4).  If the temperature or pressure is 

outside limits for that camera, a warning window will alert the user.  The Temp-Pressure 

Warning button in the bottom left of the Configure window allows the user to prevent 

the window from popping up but still monitor the temperature and pressure so that the 

user can review it.  The Temp-Pressure Monitor button can be used to turn off the 

temperature and pressure monitoring.   

The TCP/IP Port control allows the port number for the TCP/IP server to be set.  The 

default of 2055 is not used by any common computer functions.  For more information 

about the TCP/IP server functions of this program, see Section 6 on page 63. 

The  button saves the information and closes the window.  The  

button cancels any changes made and closes the window. 

3.1.4 Monitoring Temperature and Pressure 

The temperature and pressure of the camera are automatically logged to an internal buffer 

on a one-minute interval.  The buffer can hold 4,500 readings providing for more than 

three days of data at the default interval.  Once the buffer is full, the oldest data is 

discarded as new data is entered.  The Monitor Temperature and Pressure menu item 

opens a window (Figure 3.5) that displays the temperature and the pressure of the camera 

in real-time.  Each data point has a date-time stamp and the graph is updated as new data 

is acquired.   The Change Sampling Interval menu item allows setting a sampling 

interval down to a minimum of 10 seconds.  To have the data logged to a disk file, select 

the Log Temp and Pressure to a File menu item.  The user is prompted to select a 

folder for the log file that is automatically named using the date, such as ‘Jan 01, 

2004.TPL’.  In this way, there is one file for each day if the logging is left on for multiple 

days.  These files can later be combined in the Temp & Pressure Log Display window.  It 

should be noted that the log file is independent from the internal buffer in that older data 

is lost from the internal buffer when its fixed size is exceeded which is not the case for 

the log file. 
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The Temp & Pressure Log Display window allows the data to be viewed as temperature 

only, pressure only or a combination of temperature and pressure by selecting the 

appropriate tab.  For cameras that have a backplate temperature sensor, which usually 

applies to thermoelectrically cooled cameras, the temperature plot will show both the 

CCD Temperature and the Backplate Temperature as shown in Figure 3.5.  The 

Backplate Temperature plot will be red and its values correspond to the Y-axis labels on 

the right side of the plot.  Each view can also be printed using its associated  

button with the ability to add a comment to the printout with the  button prior 

to printing.  The individual Temperature and Pressure views allow a more detailed 

analysis of the data with a movable cursor in an expanded display with plot scaling and 

zooming similar to other graphs in this program.  The Temperature & Pressure tab 

provides more of an overview with the standard zoom and pan controls and separate 

buttons for auto-scaling the individual plot axes and a scale-all-axes button.  The single 

time axis labels at the bottom of the pressure plot apply to both plots.  The temperature 

and pressure indicators at the top of the window display the latest measurements taken.  

The   button allows the live update to be paused while the graph on the 

 

Figure 3.5  Monitor Temperature and Pressure window 
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screen is being manipulated or examined.  If the live update is not paused while the graph 

is zoomed in on a region, the graph will auto-scale when an update occurs to display 

newest data point.  The live update is automatically paused when a data set is opened or if 

an additional data set is added to the plot.   

The File menu, Figure 3.6, allows the user to open and save the 

logged data.  Open Data Set opens a previously saved data set and 

Add Data allows a data set saved to a file to be added to the current 

data set displayed.  Since the data is saved with a real-time stamp for 

each data sample, the Time axis will display real time for the 

composite data set.  Save allows the currently displayed data set to 

be saved to a file that can later be opened in the Temperature & 

Pressure Log Display window.  Export will export the current data 

set to a CSV (comma separated value) file that can easily be read by 

other programs such as Excel.  Excel will automatically open a CSV 

file and the first column will be in Excel’s default data-time number 

(days since January 1, 1900).  If the format of the first column is set to a custom format 

of  “mm/dd/yyyy h:mm:ss”, it is a readable date-time stamp.   

The  button allows the data in the graph to be averaged over time.  It is an 

On/Off button and the data will be processed using the  control to set the 

time over which to average the data.  A value of  05:00 will average each successive five 

minutes of data.  When averaging is on, it is applied to either the live data or data opened 

from a file.  When the Time Avg. value is changed, the original data is processed using 

the new value and displayed in the graph. 

An additional set of indicators at the top of the main SI Image 

window to the left of the Continuous button (Figure 3.7), 

indicate temperature and pressure warnings.  These LEDs are 

visible only when an error condition exists.  From the top down: 

1. Yellow – CCD temperature is too high 

2. Blue – CCD temperature is too low 

3. Red – Camera pressure is too high 

4. Orange – Camera pressure is too high for the current temperature 

The limits that trigger these warnings are in the settings file and are entered when the 

camera is built and configured.  If the mouse dwells on one of these LEDs, a tip strip will 

appear describing its function.     

 

Figure 3.6  

Temperature & 

Pressure Log Display 

File Menu 

 

Figure 3.7  

Temperature and 

Pressure Warnings 
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3.1.5 TCP/IP Server 

The TCP/IP server allows remote control of a subset of the SI Image program’s 

functions.  This is useful where another program is used for control of a process that 

needs to initiate an image acquisition in the SI Image program.  These two programs can 

run on the same computer or on different computers that are connected over a network.  

The camera is physically attached to the computer running the SI Image server where the 

user initializes the camera and sets all the camera parameters in the SI Image program.  A 

remote client can then initiate an image or averaged image acquisition of a specified 

exposure time to a specified buffer (Image 1 or Image 2).  Modes can be selected where 

the image is saved on the local computer that is controlling the camera and/or transmitted 

to the client.  The client can also inquire the camera status and obtain the image header 

that contains all the operating parameters of the camera during the last image acquisition.  

A full description of the server protocol is described in Section 6.  The SI Image program 

is still fully functional while the TCP/IP server is enabled. 

The TCP/IP Server menu item enables on the TCP/IP server in the SI Image program.   

Once enabled, a new button, , appears at the top of the SI Image window and the 

server waits for a client to make a connection on the TCP/IP port that is set in the 

Configure window.  When a client makes a connection, the button changes to  

indicating a connection has been made.  At this point, the program can be used normally 

and also receive commands via TCP/IP.  To disable the TCP/IP server, press the  

button and it will switch to the Off position and disappear from the window and the 

server is no longer active. 

3.1.6 DSP Utilities 

The DSP Utilities 

consist of three items, 

Download DSP Code, 

Reload DSP Code 
From EEPROM and 

Save DSP Code to 
EEPROM.  These are 

not used in normal 

operation of the camera 

since Initialize will 

automatically download 

the DSP code, specified 

in the settings file 

described later, if 

necessary.  Download DSP Code is used when the DPS code in the camera needs to be 

replaced with a newer version.  If this is the case, the new DSP code needs to be placed in 

the folder with the program and the new DSP code file name needs to be entered into the 

Figure 3.8  DSP Utilities 
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control in the camera configuration described above in Section 3.1.3.  Once new DSP 

code has been downloaded, the Save DSP Code to EEPROM menu item saves the 

current DSP code into the EEPROM in the camera as the default DSP code.  In 500 

Series and most 600 Series cameras that do not store the DSP code in the camera, the user 

will see an error message since the command could not be executed.   The Download 

DSP Code may be necessary to reset the camera if a communications error occurs and 

Initialize does not restore proper operation of the camera.  An alternative to downloading 

the DSP code in this situation is to select the Reload DSP Code From EEPROM 

operation that is available on camera models 850 and higher.  This operation performs a 

“warm boot” of the camera without requiring the camera power to be cycled.   

3.1.7 Stop 

The Stop menu item halts the program but does not exit as is done by the Exit item on 

the file menu.  In this case, the program can be restarted by pressing the  button that 

appears on the left side of the toolbar near the top of the window when the program is 

stopped.  When the program is restarted, all image buffers are cleared so any images that 

were not saved are lost. 
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3.2 CCD Settings   

The  button opens a window (Figure 3.9) where all the operating 

parameters of the camera can be set. The parameters that are changed in normal operation 

are accessible in the main Camera Settings tab.  Two groups of more detailed settings 

that are not changed as often are accessed by the tabs labeled Readout & Format and 

Configuration. 

3.2.1 Camera Settings 

The CCD Format Parameters control the region of the CCD that is used and the 

binning.  The Origin values are in unbinned pixels.  The serial origin is often non-zero 

since there are usually “prescan” pixels at the beginning of the serial register that are not 

light sensitive.  The Origin can be set so these pixels are not included in the image.  If 

 

Figure 3.9  CCD Settings Window 
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binning is being used, the Length specified is for binned pixels.  For example, if the 

CCD has 1024 pixels in the serial direction, the origin is set to 0 and binning to 2, the 

length should be 512 to cover the full length of the CCD.  The postscan values are 

calculated automatically and can be viewed along with the more detailed readout and 

format parameters by selecting the Readout & Format tab.  The CCD ROI indicator 

shows the region of the CCD that is defined by the CCD Format Parameters.  The CCD 

sensor area is indicated by the reddish-brown colored filled rectangle while the black 

rectangle shows the area to be readout.   

The Readout Mode control selects the readout mode to be used (up to 16 modes can be 

defined, 0-15).  Usually the readout mode sets the readout speed which includes setting 

the DSI Sample Time, Attenuations and Port Offsets that are applicable for the specific 

camera.  A short summary of the mode is given on the pull-down menu control.  The blue 

LED indicator above the right corner of the Readout Mode control is illuminated when 

the camera has the ability to store readout modes in the camera’s EEPROM.  In this case, 

the Get Mode From: control is also present and allows the user to select whether to get 

the mode information from the camera or from a *.set file.  The readout mode can be 

used to set any of the Readout & Format or Configuration parameters allowing for quick 

and flexible changing of the camera operation.  Following a discussion of the Readout & 

Format and the Configuration parameters, the use of Readout Modes and *.set files are 

covered (Section 3.2.4). 

The  button turns the CCD cooling On/Off.  On some older 600 series 

cameras that do not have an external relay box, this button is not operational.  For 

cameras that use thermoelectric cooling, it is important to have the cooling water flowing 

or the fan operating for air cooled cameras before turning the CCD cooling on.  

CryoTiger cooled cameras with a relay box, have a short delay of ~45 seconds before the 

CryoTiger turns on. 

All the camera settings can be printed out using the  button in the 

lower right of the CCD Settings window.  This prints all the Readout & Format and 

Camera Configuration parameters on a single page.  This printout is part of the camera 

documentation and test results that are supplied with the camera.  It provides a good 

backup of the camera settings in case of a computer malfunction or when the camera is 

routinely used in different configurations. 
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3.2.2 Readout and Format Parameters 

The Readout & Format tab (Figure 3.10) shows the detailed readout and format 

parameters for the camera.  These items are automatically changed as part of the readout 

mode in normal operation of the camera but are available to the user for inspection and 

can be modified for more advanced applications.  Some of the controls are numeric input 

and some are pull-down menus.  The pull-down menus are used for items that have only 

pre-defined values that are associated with the text on the menu.  Those values are 

defined in the configuration file for the camera’s DSP code.  If the camera uses the DSP 

code 4840G.bin, the configuration file would be 4840G.cfg.  Both of these files are 

installed with SI Image SGL in the same folder as the executable.   

 

 

Figure 3.10  Readout and Format Parameters Window 
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The CCD format parameters are the same as in the main Camera Settings tab with the 

addition of the Post Scan values.  The Exposure Time is the same as setting the 

exposure time from the main front panel except that here it is in units of ms.  Continuous 

Clear controls whether the CCD is in a continuous clear mode between image 

acquisitions.  The default value is Enabled.  Disable for One Cycle disables the 

continuous clearing until the next image is acquired, at which time continuous clearing is 

automatically re-enabled.  Some cameras also have an additional mode, Disable, where 

the continuous clear is disabled and not re-enabled after an image acquisition.  See the 

camera hardware manual for details. 

The DSI Sample Time, Attenuation, Port Offsets and Port ADC Offsets values are set 

automatically when the Readout Mode is selected in the main Camera Settings tab but 

can be overridden with these controls for advanced applications.  In Figure 3.10, offsets 

are shown for Port 1 and Port 2 since a two port camera was being used.  Other cameras 

may have single port or four port readout capability and therefore display a different 

number of port offset controls.  Also, not all cameras use a Port ADC Offset, so those 

controls may not be present.   

The DSI Sample Time (Dual Slope Integrator) is the parameter that permits the camera 

readout speed to be changed in order to balance readout noise against readout time.  

There are pre-defined values that correspond to the readout speeds in the menu control 

for which the camera has been optimized and tested.  This parameter is functional only 

for cameras that use a dual-slope integrator as the analog processor for correlated double 

sampling.  For a discussion of correlated double sampling and the dual-slope integrator, 

see “Electronic and Computer-Aided Astronomy”, Ian S. Mclean, Ellis Horwok 

publisher, (1989).  Dual-slope integrator analog processors are generally used in Spectral 

Instruments cameras that have maximum readout speeds of 1 MHz or less.   

Increasing the DSI parameter slows the readout speed by 100 ns per increment, resulting 

in higher sensitivity (lower electrons/ADU) and better signal to noise ratio.  The 

sensitivity scales linearly with the sampling time, and the signal-to-noise improves 

approximately with the square root of the sampling time.  The particular CCD type and 

the analog processor used in the camera establish the minimum and maximum practical 

sampling times.  The test data shipped with the camera includes results of performance at 

both typical minimum and absolute maximum DSI sample times.   

The analog attenuation parameter is used to reduce the sensitivity of the analog 

processor; increasing the number of electrons/ADU.  This is useful in situations where 

the CCD is being operated near full charge capacity in binned mode, or to offset the 

increased sensitivity of a camera that is being operated with a slow readout speed.  The 

magnitude of attenuation and the number of attenuation settings depend upon the camera 

configuration.  These data are provided in the camera test data document shipped with 

each camera system. 

The TDI Delay is the Time Delay Integration delay that is used when the camera is run 

in TDI mode.  The delay is in µs and sets the delay between parallel shifts on the CCD. 



   

 33 

Depending on a camera’s abilities, there may be more or less parameters in the Readout 

& Format tab.  The parameters discussed above are common to most cameras (with the 

exception of Port ADC Offsets).  Below are parameters that are used by some newer 

cameras.  Future cameras may include parameters that are not covered here. 

Abort Mode:  Selects whether to perform a readout of the CCD or not when an 

acquisition is aborted during the exposure time.  This allows preserving any image 

information acquired prior to the abort. 

Command on Trigger:   Selects what camera operation to perform when an external 

trigger is received.  Cameras that do not support this parameter, perform a Light 

Exposure by default. 

CCD Attenuation:  Used on some CCDs to select for either high sensitivity or high 

dynamic range operation. 

# of Frames:  Some cameras have the ability to acquire multiple frames with a single 

acquire command.  This parameter sets the number of frames to acquire and is discussed 

in more detail later. 
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3.2.3 Camera Configuration Parameters 

The Configuration tab allows the user to view and change camera configuration 

parameters.  These parameters are stored in nonvolatile memory (EEPROM) in the 

camera controller.  When the camera is initialized, the parameters are read back from the 

camera.  These parameters are not usually changed except during initial camera setup and 

testing at Spectral Instruments.  Changes can be made without writing to the EEPROM 

by changing the parameters and pressing the  button.  In this case, the parameters 

are sent to RAM in the controller and not written to the EEPROM.  They remain in effect 

only until the camera is initialized again.  If the  button is pressed, any changes 

made are canceled.   

 

Figure 3.11  Camera Configuration Window 
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The first three parameters are self-explanatory.  The Phasing, Split, Number of Ports 

and Port Select parameters are interrelated and used to select the port/ports from which a 

CCD is read out.  Currently the software supports one, two and four port readout CCDs.  

Serial and Parallel Phasing control the direction of the shift in the serial and parallel 

registers.  This is used when selecting ports of a multiport CCD to be used for readout.  

The phasing is controlled by a pull down menu and can be Normal or Reversed.    Some 

CCDs do not allow the phasing to be reversed and in that case there will only be Normal 

as an option on the control.     

Serial Split and Parallel Split define whether the respective register is split such that 

image data is read out to multiple ports.  The Split controls select either Normal or Split.  

The split is only used in multiple port cameras.  The normal setting for four-port readout 

is to have serial and parallel set to Split and phasings set to Normal.  When both the 

registers are split, the phasing is overridden since the charge is being shifted in opposite 

directions in the two halves.  In the case of a 2 port CCD that has port A on one end of 

the serial register and port B on the other end with Serial Split set to Normal (one port 

readout), Normal phasing would direct the readout to port A and Reversed to port B. 

When doing a multiport readout, the Number of Ports and Port Select also need to be 

set properly.  In the case of a four port CCD, Number of Ports would be set to 4 Ports 

and Port Select would be set to ABCD.  When multiple ports are used, the Serial and 

Parallel Size parameters correspond to the actual physical size of each section of the 

CCD.  For a 4K x 4K CCD with four ports, the size parameters would be 2K each for 

serial and parallel when in 4 port readout mode.  Depending on the particular CCD and 

the electronics, there may be some restrictions on how it can be read out. 

Parallel Shift Delay is the delay between the timing states when doing a parallel shift.  

This parameter is in increments of 100 ns.  This parameter should normally be left at the 

factory set value. 

Shutter Close Delay is the delay after the shutter is closed before the CCD readout 

begins.  This delay is in 1 ms increments and must be >0. 

All temperature parameters are entered in the units indicated on the control. 

CCD Temp. Setpoint Offset is a single point correction for the temperature calibration 

(not used in all cameras). 

CCD Temperature Setpoint is the temperature to which the camera cools.   

Low Temp Limit is the lowest temperature that the camera should be operated at.  This 

is important in cameras that have a fiber optic bonded to the CCD so as not to damage the 

bond.  Also, when a CCD gets too cold, the charge transfer efficiency (CTE) degrades.  

This usually happens somewhere between -105 and -120 °C.  If the CCD temperature 

goes below the set limit, a warning window is displayed. 
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Operational Temp is the temperature above which a warning window will be displayed 

to alert the user that the camera is warming up.  The warning window will not be 

displayed until the camera has been cooled below the Operational Temp first. 

As with Readout & Format parameters, depending on a camera’s abilities, there may be 

other parameters in the Configuration tab.  The parameters discussed above are common 

to most cameras.  Below are parameters that are available in some newer cameras.   

Cold End Temp Setpoint is the setpoint temperature for the cold end of the CryoTiger 

cooler on the 1100 series cameras. 

Backplate Temp Offset is a single point correction for the temperature calibration for 

the backplate of thermoelectrically cooled cameras (not used in all cameras). 

MPP Mode controls whether the CCD is in MPP mode, value of 0, or non-MPP mode, 

value of 1.  MPP stands for Multi-Pinned Phased and is also referred to as inverted mode.  

For a discussion of MPP mode operation of a CCD, see “Electronic and Computer-Aided 

Astronomy”, Ian S. Mclean, Ellis Horwok publisher, (1989).  Not all CCD sensors can be 

switched between MPP and Non-MPP mode. 

Frame Transfer allows the switch between normal and frame transfer readout on CCDs 

that have frame transfer ability.   

Window Heater turns the window heater On/Off. 

Operational Pressure sets the maximum pressure that is allowed at or below the 

operational temperature before a warning window is displayed. 

High Pressure Limit is the maximum pressure allowed at any temperature before a 

warning window is displayed. 

BP Sensor Override is used during the camera manufacturing and should not be needed 

by the end user.  It allows the camera to be operated before the backplate temperature 

sensor is installed. 

Cooler is an On/Off parameter the controls the camera cooler.  On cameras that have this 

parameter, it is automatically set by the Cooler button on the Camera Settings tab. 

Trigger Out Selector and Trigger In Selector control whether the triggers are opto-

isolated or TTL. 

Trigger Input controls whether the trigger input is set to pull-up or pull-down. 

UART 100 byte Ack is used to turn On/Off the camera waiting for an acknowledge byte 

after every 100 bytes sent on the serial communications line.  This was added for the 

Linux operating system where data can be lost if the interrupt is not serviced before the 

UART FIFO buffer is full. 



   

 37 

CryoTiger Low-Flow Begin and CryoTiger Low-Flow End are on some 1100 series 

cameras to reduce the CryoTiger gas flow once the camera is at a low temperature.  This 

reduces the need for heating the CryoTiger gas lines. 

Pixel Clear is the time in ns to clear a single pixel on the CCD.  This can be used to 

calculate the time required to clear the CCD when the CCD is in continuous clear mode 

(normal mode of operation). 

3.2.4 Readout Modes 

The Readout Mode control, , on the Camera Settings tab is 

a pull-down menu that allows selection of the different readout modes that are configured 

for the camera system.  The standard modes set up at the factory are normally the 

different readout speeds at which the camera is configured and tested.  In cameras that 

have the ability to save this mode information in the camera, all mode information is read 

from the camera when it is initialized.  When the CCD Settings window opens the first 

time, an indicator displays that mode information is being read from the camera.  Other 

indicators that the camera is capable of storing modes are: the blue LED above the 

Readout Mode control, the text in the Readout Mode control is blue and the Get Mode 

From: control is present.  The Get Mode From: control has two options, Camera or 

*.set file.  For cameras that do not have the ability to store mode information in the 

camera, it is always taken from the *.set file.  Cameras that are mode-capable are shipped 

with a *.set file which can serve as a backup of the information in the camera.  The *.set 

file is a text based file with sections and items within each section.  Section names are 

enclosed in square brackets and include: [Camera Operations], [Readout & Format], 

[Readout Mode N] where N can be 0 to 15, and [Configuration].  Within each section are 

the parameter names and assigned values, e.g. Analog Attenuation=0.  As mentioned 

above, the preset modes for a camera are normally the different readout speeds at which 

the camera has been configured and tested.  The readout speed requires that the DSI 

Sample Time, Analog Attenuation, and the Port Offsets be set as these values are 

different for different readout speeds.  When a Readout Mode is saved, a window pops up 

to let the user select what parameters are changed when that mode is selected.  Figure 

3.12 shows this window, selecting the parameters to set the readout speed on a camera 

that has a CCD with two ports (as seen by the two Port Offsets and two Port ADC 

Offsets.)  Parameters that have been previously selected as part of the readout mode will 

already be selected (highlighted).  Parameters can be selected using the mouse by a Ctrl-

Click to select or deselect individual items.  A click followed by a Shift-Click will select 

the multiple parameters between the two selected parameters while deselecting any others 

in standard Windows behavior.  Once the parameters are selected, pressing the 

 button will save the mode information to the camera for mode 

capable camera and to an internal data structure that is used to save it to a settings (*.set) 

file. 
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The  button saves the current readout and format parameters and all 

the readout mode settings to a *.set file that can later be recalled using the 

 button.  There is an option check-box when opening a *.set file to 

use its Configuration parameters.  The default is to only use the Readout & Format 

parameters.  Cameras that do not have the capability to store readout modes in the 

camera, use the *.set file to get the readout mode information.  It also serves as a backup 

of what is in the camera.  When a *.set file is opened, the mode information is read from 

the *.set file into the programs internal date structure.  If the Get Mode From: control is 

set to “*.set File”, when the Readout Mode is changed, the information will not be 

recalled from the camera but from the data structure in the program.  In this way, readout 

modes can be read in from a *.set file and stored into the camera on mode capable 

cameras. 

 

Figure 3.12  Mode 0 window setting only the readout speed. 
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The  button takes the information of the current mode and uses it 

as base for a new readout mode that uses the next available mode number and sets the 

Readout Mode control to the new mode.  From here the parameters can be modified and 

a new mode saved.  Note that the text on the Readout Mode control will not change until 

the mode is saved.  The  button will delete the highest number 

mode (last mode on the pull-down menu). 

Readout modes can also be used to set any combination of parameters.  One example 

would be to change from a single port readout to a two port readout.  In that case the 

Readout Mode control text will contain more information since more parameters are 

being changed, .  The Save Mode window for this 

“Mode 10” is shown in Figure 3.13.  This example is for a two port CCD that has a 

readout port on each end of the serial register, an e2v 42-20 CCD.  The configuration 

parameters for the serial register must be set along with Number of Ports and Port 

 

Figure 3.13  Save a mode that changes the number of ports. 
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Select parameters.  The Serial Phasing is set to Normal, the 

Serial Split is set to Split and the Serial Size is set to one 

half the full serial register since it is split.  In this case that is 

1074 since there are 50 prescan pixels and 1024 active pixels 

on each half of the serial register.  The CCD Format 

Parameters must also be set to reflect the parameters for 

each port.  Figure 3.14 shows the format parameters for this 

readout.  The Serial Origin has been set to 50 so that the 50 

prescan pixels are discarded and the Serial Length has been 

set to 1024 which is half the active pixels in the serial 

direction.  The parallel format parameters are set for the full 

active area in the parallel direction.  This provides for a two 

port readout of the entire active area of the CCD.  The readout speed parameters 

mentioned above are also included in the mode.  This use of modes allows for fast and 

convenient changing of the number of ports to be used.   

Another situation where it is desirable to change more than just the readout speed with a 

mode is when focusing the camera.  When focusing, usually the fastest readout speed is 

wanted and a ROI is set to enable faster image update.  A mode could be used here to set 

the speed and a particular ROI useful for focusing.  Modes can also be used to quickly 

change the binning of the readout at set readout speeds.  In this case, only Readout & 

Format parameters for readout speed and format would be selected. 

The default readout mode that is loaded when the camera is turned on is Mode 0.  The 

 button reads the power on default parameters from the EEPROM.  

Since Mode 0 is the default mode, the  button is only shown when in 

Mode 0.  When it is pressed, a warning screen pops up to warn the user that the values in 

the EEPROM will be overwritten.  Care should be taken here, especially with the 

Configuration parameters, because these settings are normally determined for each 

camera for optimum performance. 

 

Figure 3.14  CCD Format 

Parameters for 2 Port 

Readout. 
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3.3 CCD Status 

The  button opens a floating window (Figure 3.15) displaying the status of 

the camera.  The status item most often monitored is the CCD Temperature since low 

noise operation is so dependant on the temperature.  Most other status items help in 

determining if the camera is configured and operating optimally.  The status is displayed 

on up to four tabs in the window, Temp & Pressure, Voltages, Flags and Other.    The 

Temp & Pressure and Other tabs are present for all cameras.  The Voltages and Flags 

tabs are used by 1000 and 1100 Series cameras but not by the 500, 600 and 800 Series 

cameras.  The example shown here is for a 1100 Series camera.  While the status window 

is open, it continues to update the status information (a green LED blinks in the upper left 

corner of the window when updating) except when image readout is taking place, at 

which time a message is displayed indicating status checking is temporarily halted.   

 

 

Figure 3.15  CCD Status Window 
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The Voltages and Other tabs display similar lists of status items as seen above.  The 

Flags tab, Figure 3.16, displays status items representing their On/Off condition.  There 

is a pull-down menu to select the group to be viewed.   

The status window is always on top of the main front panel and is moved by dragging the 

window by the title bar.  The status display table can be extended by using the mouse to 

pull the bottom of the window down.  Pressing the  button stops status 

checking and closes the window.  It is not recommended to leave the status window open 

while taking important images since the continuous clearing of the CCD is interrupted to 

service the status request.  The status is automatically taken following each image 

acquisition and placed into the image header that is saved with the image. 

 

Figure 3.16  Flags Tab in the CCD Status Window 
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3.4 Acquiring an Image 

Image acquisition is initiated by the 

controls in the upper right of the 

front panel (see Figure 3.17).  There 

are two image buffers, Image 1 and 

Image 2, for acquiring images.  The 

pull-down menu next to each acquire 

button selects the type of image to 

acquire.   

The selections are shown in Figure 

3.18.  Light Exposure opens the 

shutter for the amount of time set in 

the Exposure Time control.  Dark 

Exposure integrates for the set 

exposure time with the shutter 

closed.  Test Image (not functional 

on 500 series cameras) instructs the 

controller to generate a test pattern 

and transmit it to the computer.  This 

is useful for testing communications 

with the camera controller.  Some 

cameras have additional special acquisition 

modes that are described in Section 5 - 

Special Camera Features.  The default 

Acquisition Mode is Single Image.  To 

acquire an image, press either the 

 or the  

button.  The new image appears in the 

display panel and the Display control, 

, indicates which image buffer 

is displayed.  The Display control also can be used to select whether Image 1 or Image 2 

is being displayed.  The  button, when pressed, initiates continuous acquisition 

into Image 1.  That is, the  button is repeatedly pressed automatically 

until the  button is pressed again to halt continuous mode.  Continuous mode is 

useful for alignment and focusing the camera. 

 

Figure 3.17  Acquire Image Controls 

 

Figure 3.18  Image Type Menu 
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Below the image acquisition controls on the front panel are 

controls for setting the exposure time and a progress indicator 

(Figure 3.19).    The Exposure Time is changed by directly 

editing the value in the control,  or by 

"nudging" the displayed value by unit increments of 1 second.  

The units of exposure time are hh:mm:ss.sss.  If an exposure is 

typed in as 60, it will be reformatted to 1:00.000 or one minute.  

The same could be entered as 1:00.  To enter a 100 ms 

exposure, enter .1.  The Progress indicator uses a sliding bar to indicate the progress of 

an image acquisition.  The bar starts out blue in color and indicates the % Exposure 

complete.   The progress bar changes to green during the readout phase indicating the 

% Readout complete.  The  indicator shows the time left to complete the 

exposure and readout of the CCD.  The time scale is in hh:mm:ss.s with hours and 

minutes being displayed only if the exposure is long enough to require it.  This indicator 

sometimes goes negative if the initial estimated acquisition time is too short.  Following 

the first acquisition, the actual time measured is used to start the countdown.  If the 

indicator goes negative by more than 10 seconds, it is most likely that an error has 

occurred and an error dialog will follow. 

3.5 Getting Statistics  

The statistics section of the front panel is 

shown in Figure 3.20.  The statistics 

information displayed is for a region of 

the image that is defined by a resizable 

box, , the diagonal corners of 

which are the position of the red cursor 

(Cur 0) and the smaller red ‘offset’ cursor, .  The position of this offset cursor can be 

changed by dragging it or by using the X and Y Offset controls on the front panel.  When 

the offset cursor is moved by dragging it with the mouse, the change is reflected in the X 

and Y Offset controls.  When an image is acquired or modified, the statistics are updated 

for the selected area.  To display the statistics for various regions of the image, drag the 

red cursor (Cur 0) to the desired region (the offset cursor will track along).  The offset 

cursor defaults to always being offset to higher pixel coordinates except when this puts 

the region outside the image.  In this case, the offset cursor is forced to be within the 

image by reflecting its position about the red cursor in either axis, while keeping the same 

offset value.  If a small LED, , appears below the Y Offset label, it is an indication 

that an error has occurred in the statistics calculation.  Clicking on the LED will open a 

dialog window describing the error. 

 

Figure 3.19  Exposure Time 

Controls and Progress Indicator 

 

Figure 3.20  Image Statistics Information 
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3.6 Special Acquisition Modes 

Other acquisition modes depend on the camera 

capabilities and are selected on the Acquisition Mode 

pull-down menu, Figure 3.21.  The first three items are 

available for all cameras while the last two, Multiple 

Frames and Focus, are available and will appear on the 

menu for cameras that have the ability to do frames 

acquisition built into the DSP code for those cameras. 

3.6.1 Average Images Acquisition 

The Average Images acquisition is not only used to achieve better signal to noise ratio in 

acquired images, but an additional option allows the user to turn on a coincidence filter to 

remove spurious events from the images while doing the averaging.  The spurious events 

filtering is discussed in Section 4.2.6 - Auto Corrections.  When the Average Images 

mode is selected, the front panel changes to reflect the options for this mode (see Figure 

3.22).  The Acquire Image 2 controls go away and the Acquire Image 1 changes to 

Acquire Average.  The Average N Images control is used to set the number of images 

to be averaged.  When the average images 

acquisition is started, a progress indicator 

appears below the Acquire Average 

button (see Figure 3.23)  The images are 

acquired into Image 1 using the current 

exposure time and the image type set for 

Image 1. 

When the first image is acquired, there is 

an exchange of Image 1 and Image 2 so 

that the averaging can take place in the 

Image 2 buffer.  It should be noted that if 

there are images in either image buffer, 

they will be overwritten when the Average 

Images is started.  The  

button allows the average images process 

to be stopped when the current image 

acquisition is complete.  When the 

selected number of images has been 

acquired, the final averaged image is 

moved into Image 1 and displayed.  

Comments are automatically generated and 

entered into the comment section of the 

image information indicating how many 

images were averaged. 

 

Figure 3.21  Acquisition 

Mode Menu 

 

Figure 3.22  Average Images Setup 

 

Figure 3.23  Average Images Progress 
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3.6.2 Multiple Image Acquisition 

Multiple Image acquisition is used to take a 

sequence of images at a set time interval.  It is 

also used to acquire a sequence of images 

using the external trigger option, which is 

discussed further in Section 5.1.  In Multiple 

Image acquisition mode, each image is saved 

to the disk automatically as a separate file.  

The Setup button is initially red and the 

Acquire Multiple button is disabled, 

indicating that the setup needs to be done 

before the acquisition can be started (see 

Figure 3.24).   

Pressing the  button brings up a 

window (Figure 3.25) that allows setting all 

the controls necessary to obtain a sequence of 

images and save them to disk.  It is in this 

window that the time interval, number of 

acquisitions and the path where files are 

saved are specified.  Care must be taken 

when setting the time interval so it is 

longer than the total acquisition time.  If 

the interval set is too short, an error 

message is displayed and the interval is set 

to a minimum value.  The time interval is 

set in hh:mm:ss.s, a format like the 

exposure time control. 

The number of acquisitions is either 

entered into the dialog box or modified by 

“nudging” the displayed value using the 

arrows.  The acquisitions are saved as files 

on disk with each image having a unique 

“name”.  This file name is composed of 

the name entered in the Data Series: 

control and a four-digit count that is 

appended to the name by the program to distinguish each image in a sequence.  The Start 

At #: control allows the user to specify what that four-digit counter should start at for the 

multiple image series. 

 

Figure 3.24  Multiple Acquisition Controls 

 

Figure 3.25  Multiple Acquisition initial setup window 
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As with regular file saving, seven file types are available as shown in Figure 3.26. The 

file type options are standard in the SI Image environment and the TIFF files can be read 

into any other program that supports the full range of TIFF file types.  The files are saved 

with a time-of-acquisition that is obtained from the system clock when each acquisition is 

started.   

To select where the 

images will be saved, 

press the  

button to open a file 

dialog window 

(Figure 3.27) and 

select the folder 

where the images will 

be saved.  The 

subsequent files in the 

multiple acquisition 

are named by 

incrementing the file 

name counter.  For 

example, as shown in 

Figure 3.25, the file 

name of the first 

image is “Multi Test 

0001.FIT”.  The 

second image 

acquired would be 

automatically “Multi 

Test 0002.FIT” and 

so on.  Once the file folder is selected, press the Select Cur Dir button to close the file 

dialog window.   

When all settings are correct, press the  button to close the setup window and 

return to the main front panel.   

With the setup complete, multiple image acquisition is initiated by pressing the, now 

enabled,  button shown in Figure 3.24.  The Progress indicator 

(Figure 3.19) shows the progress of each image acquisition and the 

 indicators display the progress in the sequence of images 

the same as when averaging images. 

 

 

Figure 3.26  File Type Selection 
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3.6.3 Multiple Frames Acquisitions 

If a camera is capable of multiple frames acquisition, that option will appear on the 

Acquisition Mode control.  Multiple Frames mode is an acquisition mode that is 

optimized for maximum frame rate by having a Readout & Format parameter for “# of 

Frames” and the camera will acquire that number of image frames following a single 

acquisition command.  This mode requires special data handling and flexible saving of 

the multi-frame images.  There are two types of multiple frames acquisition, Single 

Frame Buffer and Multiple Frame Buffer.  In both types, each frame from the camera 

is captured in the computer into a single frame DMA (Direct Memory Access) buffer.   

In the Single Frame Buffer type, the image is copied and de-interlaced if necessary 

(multi-port readout requires de-interlacing) into a second single-frame buffer and 

simultaneously written to a multi-framed unsigned 16 bit integer (U16) FITS file on the 

hard drive.  In this way, the memory requirement is minimized since single frame buffers 

are used and the number of frames is limited by the maximum disk file size of the 

operating system.  The limitation is the speed that the frames can be written to the hard 

drive.  The camera will send the frames as they are acquired and the computer must de-

 

Figure 3.27  *.set File Path Dialog Window 
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interlace the image and write it to the hard drive fast enough so there is no overlap of 

frames in the DMA buffer.  The de-interlacing of a subsequent frame is held off until the 

previously de-interlaced buffer is written to the hard drive.  In tests on a 2.8 GHz Pentium 

IV computer, 2106 x 2092 pixel frames were successfully acquired at about 2 frames/sec. 

while writing to the hard drive.  This required a throughput from the camera to the hard 

drive of 16.8 MB/sec.  If there is an overlap of frames, an error dialog will inform the 

user at the end of the acquisition sequence.   

When Multiple Frames is 

selected, the front panel 

changes as shown in Figure 

3.28.  The Setup button is red 

at first indicating that the file 

where the multi-frame image 

will be written needs to be set.  

In the setup window, the file 

naming and the path are 

entered.  There are two naming 

convention options shown in 

Figure 3.29 and Figure 3.30.  

The date and time can be used 

as the file name or a series 

name can be entered and a 

counter in the file name will be 

incremented.  In this way, the 

setup need only be done once 

and each subsequent multi-

frame image is given a unique 

file name automatically.  The 

path is selected by pressing the 

Select Folder button and 

navigating to the desired folder 

in the file dialog window and 

pressing the Select Cur Dir as 

discussed above for Multiple 

Image Acquisition mode.   

In the Multiple Frames mode 

there is an additional control, 

, that enables the 

display updates to be turned off 

during the multiple frame 

acquisitions.  Depending on the 

speed of the computer and its 

graphics system, turning the 

 

Figure 3.28  Multiple Frames Mode 

 

Figure 3.29  Multiple Frame File Setup using Data-

Time 
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update off can allow the computer to 

keep up with the incoming image 

data.  The update is On by default.  

At the end of the acquisition 

sequence, only the last frame is 

displayed.  A function to look at the 

frames from a multiple frame image 

file is discussed later. 

In the Multiple Frame Buffer type 

of acquisition, the DMA buffer is de-

interlaced into a multiple frame 

buffer and not saved to the hard 

drive.  Once the frame sequence is 

finished, the entire multiple frame 

image is in the program and can be 

saved as a normal image, but it is a 

multiple frame image.  No Setup is 

needed since the file is saved with the usual file functions.  The advantage of this type of 

acquisition is there is no limitation imposed by having to save the frames to the hard 

drive as they are acquired and the entire image is available in the program at the end of 

the sequence.  The disadvantage is that there has to be enough memory in the computer to 

hold the, possibly very large, image.  Keep in mind that several buffers may be created by 

the program as different image manipulations are performed.  Once the physical memory 

available in the computer is filled, the operating system 

will start swapping RAM memory to the hard drive and 

the speed of the computer will slow greatly and may 

cause problems with the image acquisition.  So, while 

Multiple Frame Buffer allows the maximum acquisition 

speed, the number of frames will be limited by the 

memory in the computer.   

Viewing the frames of a multiple frame image can be 

done a few different ways.  If the image is acquired using 

the Multiple Frame Buffer type or a multiple frame file 

is opened using the Open Image item on the file menu, 

all the frames are in the image display buffer.  The image 

as viewed in the image display of the program has the 

multiple frames along the X axis of the image display.  

The Video Frames item on the View menu, Figure 3.31, 

opens a floating window (see Figure 2.16) to control the 

X axis of the image display for viewing individual frames 

of a multiple frame image.  This is discussed in section 

2.3.4.  Alternatively, the Show Image Scroll Bar item on 

the View menu can be selected and a scroll bar appears 

below the image display that can be used to scroll the 

image display along the X axis.  Using either these 

 

Figure 3.30  Multiple Frame File Setup using Series 

 

Figure 3.31  View Video Frames 

from Multiple Frame Image 
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methods requires that enough computer memory is 

available since the entire multiple frame image is 

resident in the memory. 

The third way to view individual frames of a 

multiple frame image file is to use the View Multi-

Frame Image item on the File menu (Figure 3.32).  

This method loads one frame at a time into the 

computer memory and into the image display.  This 

way a very large multiple frame image can be 

viewed.  When this is selected, a file dialog window 

allows the multiple frame image file to be selected.  

Next the View Multiple-Frame Image control 

pops up (Figure 3.33) in a floating window and the 

first frame is read and displayed in the image 

display.  The controls are the same as used 

in the Video Frames Control window.  One 

additional item is the Log Data button that 

enables the region statistics data from the 

image frame to be logged to a file as the 

frames are played back.  The Delay (s) 

control sets the dwell time in seconds for 

each frame during playback.  Any individual 

frame can be saved to a new single frame 

file by stopping the viewing and doing a 

normal Save Image from the File menu. 

 

 

 

Figure 3.32  View Multi-Frame 

Image 

 

Figure 3.33  View Multiple-Frame Image 

Control 
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3.6.4 Focus 

 

The last acquisition mode is Focus.  This mode is only available on cameras that have 

multiple frames ability.  In this mode, the main image acquisition button becomes 

 and will open a window, Figure 3.34, that is a floating window and its 

display is optimized for speed.  The camera is put in a continuous acquisition mode using 

the exposure time and readout speed set in the main program window.  Images cannot be 

saved from this window as it is meant only for viewing during instrument adjustment.  

When the first frame is acquired, the image display scales the Z or intensity axis 

automatically once.  After this, display can be scaled by pressing the Z Scale button or by 

using the Z Scale slider controls to the right of the image display. 

 

 

 

Figure 3.34  Focus Window 
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4 Image Math 

4.1 Math Menu 

Image arithmetic operations and image exchange are included under the Math menu 

shown in Figure 4.1.  All image math functions are performed in the default SI Image 

SGL single precision floating point arithmetic model. 

Four image arithmetic 

functions are provided to 

combine Image 1 with 

Image 2, the results 

replacing the prior contents 

of Image 1.  The images 

must be the same size to 

perform image arithmetic.  

Simple image addition, 

subtraction, multiplication, 

and division are obtained 

by these functions.  The 

result, which is entered into 

Image 1, is displayed and 

any plot or histogram 

currently selected is 

updated along with the new 

display.  The "stats box" is also updated after every arithmetic operation. 

Functions are provided to add a constant to Image 1, multiply Image 1 by a constant, 

divide Image 1 by a constant and divide a constant by Image 1.  Selecting Image 1 + 

Constant →→→→ Image 1 function brings up the dialog box shown in Figure 4.2.  The 

value of the constant used previously is displayed and may be accepted by clicking the 

OK button or modified either by selecting the 

displayed number and entering a new value or 

by "nudging" the displayed value by the 

arrows.  A similar window is used to enter the 

constant for the other constant operations. 

 

 

Figure 4.1  Math Menu 

 

Figure 4.2  Add Constant to Image 1 
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The post binning function (Figure 4.3) allows 

the image to be arithmetically binned after an 

acquisition has taken place as opposed to 

normal binning that takes place on the CCD.  

There are three preset binning options and a 

user defined option.  When the user defined 

option is selected, a widow (Figure 4.4) allows 

the user to set arbitrary binning factors. 

Since most image functions involve Image 1, 

Exchange Image 1 and Image 2, 

allows the interchange of the contents of Image 

1 and Image 2. 

 

4.2 Image Corrections Menu 

The Image Correction menu, Figure 

4.5, allows different image corrections 

and correction options to be 

implemented.  When the program is 

first started, some of the menu items 

are disabled, such as the Correct 

Defects menu item in Figure 4.5.  

The items become enabled when the 

correction map file is opened in the 

correct defects case, the images are set 

for flat field calculations or 

background subtraction or when the 

serial overscan bias region is set.  

4.2.1 Flat Fielding  

Flat fielding corrects for non-uniformity in the optics and pixel-to-pixel variations in 

sensitivity of the CCD.  Initially, the Calculate Flat Field menu item is disabled 

until the flat field image is established.  The recommended procedure is to first collect a 

dark image for the same exposure time to be used for the flat field image.  For best signal 

to noise, the dark image should be the average of several acquisitions, with spurious 

 

Figure 4.3  Post Binning Menu 

 

Figure 4.4  User Defined Binning 

 

Figure 4.5  Image Correction menu 
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events correction and defects correction set, creating a “master dark image”.  Save this 

master dark image to a file.   

Next, the flat field image must be collected.  To flat field an image it is necessary to 

obtain a flat image that has an average pixel value well above the dark signal level.  

Generally, a flat field mean level above ¼ saturation is preferred to preserve significance 

in the result.  The image should be flat!  This is not easy to achieve in most circumstances 

because it means that the field being viewed must be imaged without a target.  The flat 

field image should also be acquired using the Average Images acquisition mode, with 

spurious events and defects correction set, to improve signal to noise.  When the flat field 

image has been acquired in Image 1, open the “master dark” image into Image 2 and 

perform a subtraction of the dark image from the flat field.  It is recommended to save 

this “master flat field” image to a file so that it can also be used later.  After saving the 

image to a file, select the Set Flat Field Image menu item to enter the image into the 

flat field calculation buffer. 

 If the images that are to be flat fielded have the same exposure time as the previously 

acquired dark, that dark can be used as is in the flat field calculation.  Otherwise, a new 

dark must be acquired using the correct exposure time (Average Images acquisition is 

recommended).  Once the dark is acquired, there are two options for how the dark will be 

used in the flat field calculation.  If the computer is short of memory for the size of the 

CCD being used, the dark image can be placed in Image 2 and the flat field calculation 

will use it from there.  If memory is not a problem, select the Set Background item 

from the menu to place this dark into special buffer for flat field calculation.  The 

advantage of this option is that the Image 2 buffer is free to be used for Average Images 

acquisition on the final image. 

It is important to note that both Set Flat Field 

Image and Set Background operate on the 

image that is in the image display.  LEDs on the 

front panel indicate when these images have been 

set.  Figure 4.6 shows these LEDs to the left of the 

Display control.  The top LED is green and indicates 

that the flat field image has been set.  The bottom LED is blue and indicates that the 

background image has been set. 

Now that the appropriate images are in place, an image can be acquired and the 

Calculate Flat Field menu item can be selected to flat field the new image.  The 

acquired image is first corrected for offset by subtracting the dark image.   The image is 

then multiplied by the mean value of the flat field correction image and divided, pixel-by-

pixel, by the flat field correction image.  Note that absolute pixel values are lost by the 

flat fielding process.  Separate application-specific calibration is required to preserve the 

numerical integrity of images that are flat fielded.  There is a more in depth discussion of 

this in the camera system user manual. 

 

Figure 4.6  Files Set LEDs 
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4.2.2 Defect Correction 

To perform defect correction on an image, a correction map file must be open.  Select the 

Open Correction Map File from the Image Correction menu and select the 

correction map file as shown below in Figure 4.7.  This file is installed when the software 

is installed and is in the same folder as the program.  The file is text based allowing 

additional entries by the user if necessary.  The format is “Column,Start,Length” 

followed by a carriage return.  Once the file has been opened, the Correct Defects 
menu item is enabled and can be selected to correct image defects.  For details about the 

correction map file, see Appendix B on page 77. 

 

Figure 4.7  Open Defects Correction Map 
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4.2.3 Serial Overscan Bias Correction 

Serial overscan bias correction can be useful when looking at a low light level image that 

is taken with a slow readout speed.  During the readout, the bias level can change a slight 

amount that is noticeable in a low light image.  This correction requires that the image be 

taken with a serial overscan meaning that the serial length has to be longer that the 

CCD’s serial length so that the overscan can be used to determine the bias and apply the 

correction.  The Set Serial Overscan Bias Region menu item opens a window (Figure 

4.8) that sets the overscan region to be used for the correction.  The values shown in 

Figure 4.8 would be for a 1024 x 1024 CCD where the serial length was set to  at least 

1100.  As images are viewed in the program with 0,0 being in the lower left of the image 

display, CCD rows are vertical and the serial overscan appears at the top of the screen.  

The correction is applied on a row-by-row basis where the average value of the row in the 

serial overscan region selected is subtracted from the entire row.  Following the 

processing of all the rows, the average of all the overscan row values is added to the 

entire image to bring the level approximate to its initial value. 

Note that the first few columns off the active portion of the image should be avoided, as 

well as columns near the end of the image.  The former are avoided to skip over CCD 

edge mask irregularities and the latter because all readout start and stop columns are 

subject to transient effects. 

 

Figure 4.8  Set Serial Overscan Bias Region 
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4.2.4 Average Images 

In addition to averaging images as they are acquired, previously acquired images loaded 

into Images 1 & 2 can be averaged as can image files from a disk.  The Average 

Images 1 & 2 menu item will do just that and put the averaged image in Image 1.  The 

Average Image Files menu item opens a window (Figure 4.9) where the image files 

to be averaged are selected.  The files are selected in the top of the window either by 

double clicking on them or by selecting and pressing the  button.  Multiple files 

can be selected by holding the Shift key for continuous selection or the Ctrl key for non-

continuous selection, while clicking on the filename, then pressing the  button.  

Once the files have been selected, press  to begin averaging.  The final averaged 

image is in Image 1. 

 

Figure 4.9  Select Multiple Files for Averaging 
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4.2.5 Subtract Background 

The Subtract Background menu item subtracts the selected background image from the 

image in the currently displayed buffer.  The background image must be set as described 

above (in Section 4.2.1 Flat Fielding) for this function to be enabled. 

4.2.6 Auto Corrections 

The Auto Corrections menu 

item (Figure 4.10) allows image 

corrections to be applied 

automatically following image 

acquisition.  When performing a 

“Multiple Images” acquisition or 

when the auto-save feature is 

turned on, any auto corrections 

selected are applied before the 

image is saved.  When acquiring 

averaged images, the corrections 

are applied to the final averaged 

image. 

The Spurious Events correction 

corrects for any random 

occurring bright pixels that can 

be caused by high-energy events such as cosmic rays.  The filter works, when averaging 

two images or during averaged image acquisition, by looking for non-coincidental hot 

pixels. To enable spurious events correction during image averaging, select the 

Spurious Events menu item shown in Figure 4.10.  When it is selected, a � appears 

next to the menu item and a red LED appears below the acquisition type control shown in 

Figure 4.11.  This is enabled by default when the program starts. 

The LEDs shown in 

Figure 4.11 are 

indicators of the 

various auto 

corrections set from 

the Auto 

Corrections menu.  

The LED on the left is 

red and signifies that spurious events will be corrected during image averaging.  If a pixel 

is determined to be a spurious event, it is not used for the averaging and the pixel value 

from the other image is used in the averaged image.  Figure 4.11 also shows the tip-strip 

that is displayed when the mouse is held over the LED for a short time.  Each LED has an 

associated tip strip that can be viewed this way.  The second LED from the left is blue 

and indicates that automatic defect correction is enabled.  After an image is acquired, if 

this is enabled, the defect correction will be automatically applied to the image.  The third 

 

Figure 4.10  Auto Corrections Menu 

 

Figure 4.11  Auto Correction LEDs 
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LED from the left is green and indicates that automatic flat field correction will be 

applied after image acquisition.  The LED on the right is purple and indicates that an 

automatic background subtract correction will be applied after image acquisition.  Note 

that the since a background subtraction is part of the flat field correction, either the flat 

field or background subtract correction can be selected, not both.  If both automatic 

defects and flat field (or background subtract) are set, the defects are corrected before the 

flat field (or background subtract) is applied.  If three corrections are set during Average 

Images acquisition, the spurious events are corrected during the averaging and the defects 

correction and flat field or background subtract are applied to the final averaged image. 

 



   

 61 

 

5 Special Camera Features 

Several operational modes of a Spectral Instruments CCD camera are used only under 

special circumstances.  These modes become available, on menus described previously, 

by entries in the file *.set.  These settings are all FALSE unless explicitly entered as 

being TRUE.  Each setting is detailed in sections below. 

5.1 Triggered Operation 

A camera can be set up to acquire an image upon receipt of an external signal.  This is 

accomplished through a contact closure or other TTL signal between two pins at a 

connector on the camera.  See the hardware manual pertaining to your camera for the 

connector location and pin specification. 

An idle camera is maintained in a state such that it is swept clear of charge continuously 

while not exposing.  This keeps the camera instantly ready to expose, which is merely 

cessation of clearing for the desired exposure time followed by reading the image after 

the exposure time has elapsed.  This instant ready condition is not of special importance 

in cameras where a mechanical shutter must open and close.  There are applications 

where the light is turned on and off externally and it is possible, through the trigger input, 

to synchronize the integration activity of the camera to the external light source. 

The SI Image program enables a triggered input 

exposure mode when the entry:  Triggered 

Acquisition=TRUE is read from the *.set settings file.  

When this software switch setting is encountered at 

startup, the program presents the additional exposure 

mode shown in Figure 5.1.  When Triggered Acq.  is 

selected, a triggered exposure commences at the next 

trigger after an Acquire Image 1, (or Acquire Image 

2) button is pressed.  When the trigger signal is 

detected, continuous clearing of the camera is 

terminated (this may take up to a few milliseconds 

depending on the CCD) and the CCD then integrates signal for a time period determined 

by the exposure time setting plus the shutter close delay time.  The shutter close delay is 

required to allow the preamplifier to turn on even though no shutter may be installed.  

Through SI Image, the minimum integration time is one millisecond.  Following the 

integration, the image is readout from the camera and displayed normally and the camera 

is ready for the next acquisition. 

Some cameras also provide a Readout & Format parameter Command on Trigger.  This 

parameter allows the user to select optional commands to be performed on trigger.   

 

Figure 5.1  Triggered Mode 
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The following table shows the current list of possible commands associated with the 

parameter value for cameras with this functionality. 

5.2 Time Delay Integration (TDI) readout Modes 

For Time Delay Integration (TDI) readout the shutter remains 

open while the camera is being readout.  This is typically used to 

allow a longer integration of objects that are moving.  In this case, 

the parallel shift on the CCD is synchronized with the image of the 

object passing across the CCD device.  This synchronization can 

be accomplished with internal timing using the Readout & Format 

parameter TDI Delay or external timing using the trigger input to 

activate a parallel shift.  In both cases the final TDI image is of 

fixed length and the size of this image is limited by the memory 

available in the computer.  The TDI modes are added to the 

acquisition mode selector (Figure 5.2) by the TDI Int.=TRUE and TDI Ext.=TRUE 

items in the [Camera Operation] section of the *.set file.  Not all cameras are capable of 

externally paced TDI acquisition.   

 

Figure 5.2  TDI 

Acquisition Mode 

Parameter Value Command on Trigger 

0 Default – Expose and Read CCD 

1 Open Shutter 

2 Close Shutter 

3 Generate Test Image 

4 Expose and Read CCD 

5 Read CCD Without Exposing 

26 Fixed Length, internally paced, TDI 

Mode Readout 
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6 SI Image SGL TCP/IP Camera Control 

All commands are sent as command packets. Parameters to the server are included in the 

Command packet as specified. The server acknowledges the command immediately with 

an Acknowledge packet. Following this, the server sends the requested Data packet(s).  

(NOTE: The commands Inquire Acquisition Status and Terminate Acquisition are 

special cases in that they do NOT return an Acknowledge packet, only a data packet.   

  Client          SI Image SGL Server 

 

 

 

 

 

 

 

6.1 TCP IP packet definition 

All transfer is binary. Data are sent in big endian format (most significant byte first).     

6.1.1 Command packet (10 bytes + parameter structure) 

Packet length   U32 - total number of bytes in packet 

Packet identifier  U8 - 128 

Camera identifier U8 - 0 for server commands, Camera number (1..max) 

otherwise 

Function number  U16 - function to be executed (1000 .. 1999) 

Parameter structure length U16 - length of parameter block following (0, if none) 

Parameter structure  Dependant on command 

6.1.2 Acknowledge packet (8 bytes) 

Packet length  U32 - total number of bytes in packet 

Packet identifier U8 - 129 

Camera identifier U8 - Camera ID (1..max) 

Accepted flag  U16 - true (≠ 0) or false (0) 

Send Command packet, 

including parameters 
Send  Acknowledge 

packet 

Wait for Acknowledge 

packet 

Send Data packet(s)  

Wait for Data packet(s)  

Execute command 
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6.1.3 Data packet (14 bytes + data structure – see below) 

Packet length   U32 - total number of bytes in packet 

Packet identifier  U8 - 131 

Camera identifier  U8 - Camera ID (1..max) 

Error Code   I32 - 0 = no error 

Data type   U16 - 2000 .. 2999 

Bytes in  Data Structure U16 - length of data structure that is following 

Data structure   arbitrary format (see 6.2 Data Packet Structures) 

6.1.4 Image packet (30 bytes + Image structure) 

Packet length   U32 - total number of bytes in packet 

Packet identifier  U8 - 132 

Camera identifier  U8 - Camera ID (1..max) 

Error Code   I32 - 0 = no error 

Image identifier  U16 - a number unique to this image 

Image type   U16 - 0=U16, 1=I16, 2=U32, 3=I32, 4=SGL, 5=DBL 

Serial Length   U16 - number of columns in the image 

Parallel Length  U16 - number of rows in the image 

Total number of packets U16 - total number of packets in this image 

Current packet number U16 - number (0..N) of currently transmitted package  

Offset    U32 - packet’s offset into the linear image array 

Bytes in Image structure U32 - length of Image structure that is following in bytes  

Image structure  n bytes of Image type data – big endian 
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6.2 Data Packet Structures 

6.2.1 Status structure 2002 (4*N bytes) 

Name Type Description 

Status Parameter 0  SGL Camera Dependant – see .cfg file 

Status Parameter 1  SGL  

Status Parameter 2 SGL  

…… SGL ….. 

Status Parameter N SGL Last Status Parameter 

SGL is Single Precision Floating Point number (4 bytes) 

The status parameters are defined in the .cfg file that came with the camera.  The file 

is linked to the DSP code,  XXXXX.bin DSP code uses XXXXX.cfg.  A camera can 

have a [Status] section and an [Extended Status] section in the .cfg file.  If an 

[Extended Status] section is present, the SI Image Server used the Extended Status to 

build the Status structure. 

6.2.2 Arbitrary byte array structure 2003 (n bytes) 

Array of n bytes n x U8 

6.2.3 Acquisition Status structure 2004 (8 bytes) 

Name Type Description 

% exposure done U16 % of the exposure time that has elapsed 

% readout done U16 % of the readout that is complete 

Relative position of readout U32 Relative position of readout pointer 

6.2.4 Image Header structure 2006 (variable length) 

Name Type Description 

Image header String Null (0) terminated FITS file header string that contains the 

required FITS entries, time, date  and all the status, readout 

& format and configuration parameters (see ) for the 

image. 

6.2.5 Command Done structure 2007 (2 bytes) 

Name Type Description 

Function Number U16 function that was executed 
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6.2.6 SI Image Settings structure 2008 (42 bytes) 

Name Type Description 

Exposure Time U32 Exposure time in ms 

Number of Readout Modes U8 Number of Readout Modes defined for the 

camera 

Readout Mode Number U8 Current Readout Mode 

Average N Images U32 Number of Images to Acquire and Average 

Frames U32 Number of Frames to Acquire 

Acquisition Mode U16 SI Image Acquisition Mode (see Error! 

Reference source not found.) 

Acquisition Type U16 SI Image Acquisition Type (see 6.3.4) 

Serial Origin I32 CCD Format Serial Origin 

Serial Length I32 CCD Format Serial Length 

Serial Binning I32 CCD Format Serial Binning 

Parallel Origin I32 CCD Format Parallel Origin 

Parallel Length I32 CCD Format Parallel Length 

Parallel Binning I32 CCD Format Parallel Binning 

 

6.3 Camera Commands:  

6.3.1 Get Status From Camera 

• Camera Command 

• Receives the camera status 

Function number: 1011 

Parameters:  none 

Returns:  Data packet 2002 (Status structure) 

6.3.2 Set Acquisition Mode 

• Camera Command 

• Sets the  Acquisition Mode  

Function number: 1034 

Parameters: U8: Acquisition Mode (0=Single Image, 1=Average, 2=Multiple 

Images, 3=Multiple Frames, 4=Focus) 

Returns:   Command Done Data packet 
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6.3.3 Set Exposure Time 

• Camera Command 

• Sets the exposure time for subsequent acquisitions 

Function number: 1035 

Parameters:  U32: Exposure time (in ms) 

Returns:   Command Done Data packet 

 

6.3.4 Set Acquisition Type 

• Camera Command 

• Sets the  Acquisition Type 

Function number: 1036 

Parameters:  U16:  Buffer Number (1 or 2) 

U8: Acquisition Type  

Returns:   Command Done Data packet 

 

6.3.5 Acquire 

• Camera Command 

• Starts an acquisition that has been setup previously 

Function number: 1037 

Parameters:  U16: Mode (see 6.3.6 below) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 below) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

6.3.6 Mode Parameter Values for Image Acquisition 

The image is always held in the selected Server Image Buffer after an image is acquired.  

Depending on the acquisition Mode, the image is transmitted to the client and/or saved to 

the Server’s disk. 

1 Acquire Image and transmit to client when Image data are available 

2 Acquire Image and hold in Server Image Buffer 

3 Acquire Image, transmit to client and save to Server’s disk when Image data are 

available 

4 Acquire Image, save to Server’s disk when Image data are available and hold in 

Server Image Buffer 

Acquisition Types: 
0=Light Exposure 

1=Dark Exposure 

2=Test Exposure 

3=Triggered Exposure 

4=TDI Internal Paced Exposure 

5=TDI External Paced Exposure 
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6.3.7 Save As Values for Image Acquisition   

0 – U16 FITS 

1 – I16 FITS 

2 – I32 FITS 

3 – SGL FITS 

4 – U16 TIFF 

5 – I16 TIFF 

6 – I32 TIFF 

7 – SGL TIFF 

 

6.3.8 Set Number of Averages 

• Camera Command 

• Sets the Number of Averages in a Average Images Acquisition 

Function number: 1038 

Parameters:  U16: Number of Averages 

Returns:   Command Done Data packet 

 

6.3.9 Set Number of Frames 

• Camera Command 

• Sets the Number of Frames in a Multiple Frame Acquisition 

Function number: 1039 

Parameters:  U16: Number of Frames 

Returns:   Command Done Data packet 

 

6.3.10 Set Multiple Frame Buffer Mode 

• Camera Command 

• Sets Multiple Frame Acquisition Buffer Mode 

Function number: 1040 

Parameters: U8: Buffer Mode (0=Single Frame Buffer, 1=Multiple Frame 

Buffer) 

Returns:   Command Done Data packet 

 

Notes:  In Single Buffer mode, the frames are saved to a multiple frame U16 FITS file 

and the file name is set to Date-Time mode. In Multiple Frame Buffer mode, if a Save to 

Server’s Disk mode is selected, it is recommended to select FITS format so that the files 

can be dealt with on a Frame basis.  
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6.3.11 Get SI Image Settings 

• Server Command 

• Gets the SI Image program settings (see below) 

Function number: 1041 

Parameters:  none 

Returns:   Data packet 2008 (SI Image Settings structure) 

 

6.3.12 Set Readout Mode 

• Camera Command 

• Sets the Readout Mode Number  

Function number: 1042 

Parameters:  U8: Readout Mode Number 

Returns:   Command Done Data packet 

 

 

6.3.13 Set CCD Format Parameters 

• Camera Command 

• Sets the CCD Format Parameters  

Function number: 1043 

Parameters:  I32: Serial Origin 

   I32: Serial Length 

   I32: Serial Binning 

I32: Parallel Origin 

   I32: Parallel Length 

   I32: Parallel Binning 

Returns:   Command Done Data packet 

6.3.14 Inquire Acquisition Status 

• Camera Command 

• Receive status of current acquisition 

• Special case command where no Acknowledge packet is returned.  Only a Data 

packet is returned. 

Function number: 1017 

Parameters:  none 

Returns:  Data Packet 2004 (Acquisition Status structure) 

U16: % exposure done 

U16: % readout done 

U32: Relative position of readout 

Notes:  No Acknowledge packet is returned 
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6.3.15 Terminate Acquisition 

• Camera Command 

• Terminates an acquisition in progress 

• Special case command where no Acknowledge packet is returned 

Function number: 1018 

Parameters:  none 

Returns:  Data Packet 2007 (Command Done structure) 

Notes: If internal buffer was created, it will be destroyed, no 

Acknowledge packet is returned. 

6.3.16 Retrieve Image 

• Server Command 

• Retrieves the current image 

Function number: 1019 

Parameters:  U16: Buffer Number (1 or 2) 

Returns:   Multiple Image packets 

6.3.17 Get Image Header 

• Server Command 

• Retrieves complete image header information 

Function number: 1024 

Parameters:  U16: Buffer Number (1 or 2) 

Returns:  Data packet 2006 (Image Header structure) 

Null (0) terminated FITS file header string that contains the 

required FITS entries, time, date and all the status, readout & 

format and configuration parameters for the image. 

Notes: sends data packet with all image header information 

6.3.18 Save Image 

• Server Command 

• Saves Image on the server 

Function Number: 1031 

Parameters:  U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

   File Name String (null terminated) 

Returns:   Data Packet 2007 (Command Done structure) 

 

NOTE:  The functions in sections 6.3.19 through 6.3.27 are redundant functions that 

were used in the Rev. C of the SI Image software.  They will still function in Rev. D but 

they do not allow for control of new features that were added in Rev. D.   
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6.3.19 Image Acquisition 

• Camera Command 

• Starts an image acquisition 

Function number: 1012 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

 

6.3.20 Dark Acquisition 

• Camera Command 

• Starts an acquisition without opening the shutter 

Function number: 1013 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

6.3.21 Test Pattern Acquisition 

• Camera Command 

• Starts an acquisition of a test pattern 

Function number: 1014 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 
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6.3.22 Triggered Acquisition 

• Camera Command 

• Starts an image acquisition with trigger 

Function number: 1016 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

6.3.23 Averaged Light Images Acquisition 

• Camera Command 

• Starts an Average Images acquisition 

Function Number: 1028 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Number of images to average (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

 

6.3.24  Averaged Dark Images Acquisition 

• Camera Command 

• Starts an Average Images acquisition 

Function Number: 1029 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Number of images to average (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 
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6.3.25 Averaged Triggered Images Acquisition 

• Camera Command 

• Starts an Average Images acquisition 

Function Number: 1030 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Number of images to average (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

6.3.26 TDI (Time Delay Integration) Acquisition, Internally paced 

• Camera Command 

• Starts an acquisition without opening the shutter 

Function number: 1032 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 

6.3.27 TDI (Time Delay Integration) Acquisition, Externally paced 

• Camera Command 

• Starts an acquisition without opening the shutter 

Function number: 1033 

Parameters:  U32: Exposure time 

   U16: Mode (see 6.3.6 above) 

   U16: Buffer Number (1 or 2) 

U16: Save As (see 6.3.7 above) 

File Name String (null terminated) 

Returns:  Command Done Data packet or Image packets depending on the 

Mode 
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6.3.28 Command Summary Table 

 

 

FUNCTION # OPERATION 

1011 Get Camera Status 

1012 Image Acquisition 

1013 Dark Acquisition 

1014 Test Pattern Acquisition 

1016 Triggered Acquisition 

1017 Inquire Acquisition Status 

1018 Terminate Acquisition 

1019 Retrieve Image 

1024 Get Image Header 

1028 Average Light Images Acquisition 

1029 Average Dark Images Acquisition 

1030 Average Triggered Images Acquisition 

1031 Save Image 

1032 TDI (Time Delay Integration) Acquisition, Internally Paced 

1033 TDI (Time Delay Integration) Acquisition, Externally Paced 

1034 Set Acquisition Mode 

1035 Set Exposure Time 

1036 Set Acquisition Type 

1037 Acquire 

1038 Set Number of Averages 

1039 Set Number of Frames 

1040 Set Multiple Frame Buffer Mode 

1041 Get SI Image Settings 

1042 Set Readout Mode 

1043 Set CCD Format Parameters 
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7 Appendix A 

A file, 2236.cfg, is opened automatically by the SI Image program.  For this reason, a file 

named 2236.cfg must exist in the directory with the SI Image software.  When the SI 

Image software is installed from the CD-ROM, the default version of the 2236.cfg file is 

installed along with the software.  Default item definitions are shown below in Table A.  

The left hand column is the file; the right hand column is annotation. 

Table A 

[Program Configurations] Section Name 

Window Left=7 Screen location for the left-hand edge of the program 

window. 

Window Top=52 Screen location for the top edge of the program 

window. 

Window Right=1016 Screen location for the right-hand edge of program 

window. 

Window Bottom=727 Screen location for the bottom edge of the program 

window. 

TCP/IP Port=2055 TCP/IP server port number 

Default Image Path=/C/Images Default path where images are saved 

Save As="SGL FITS" Default image file type – must be in quotes since there 

is a space in the string 

Acq Alert Delay=30.0 Delay is seconds before an alert window will appear 

after an image acquisition is complete if there has 

been no user interaction with the program. 

Auto Correct Perspective=FALSE When TRUE, the X and Y scale of the image display 

are adjusted to ensure that he geometric perspective is 

correct. 

Error Window Timeout=-1 When set to -1, an error window will remain open 

until the user interacts with it.  Otherwise this set the 

time in seconds until an error window will 

automatically close. 

Temp-Pressure Warning=TRUE Enable or disable the temperature/pressure warnings 

Temp-Pressure Monitor=TRUE Enable or disable the background monitoring of the 

temperature and pressure of the camera. 

 

The structure and entries within this file are universal across all of the cameras offered by 

Spectral Instruments.  The 2236.cfg file contains only program specific information.  All 

camera specific information is contained in the *.set file described in the next section.  

The file itself is an editable text file and can be changed using a text editor.  It can also be 

conveniently changed using the Configure menu item in the Operate menu of the SI 

Image SGL program. 
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8 Appendix B 

A file, *.map, contains the defect correction information for the associated camera.  The 

name of the *.map file is normally the camera serial number followed by “Defects.map” 

(e.g. 600-169 Defects.map). 

The content of the file is a comma-delimited table consisting of the column number, the 

location within the column and the number of contiguous pixels in that defect within that 

column.  The table is generated from images taken with the serial and parallel origins 

both 0.  Corrections from the table are mapped to the target image with the readout and 

format parameters taken into consideration. 

This file can be edited using a text editor to add a defect to the map.  The first line of the 

file specifies the binning (1,1,Binning) that was used to determine the column, start and 

length values in the file.  If this line is not present, 1 x 1 binning is assumed.  The second 

line (Column,Start,Length) is required.  

Table C, below, illustrates a typical configuration for the *.map file.  The left hand 

column is the contents of a example file, the right hand column is annotation. 

Table C 

1,1,Binning Specifies that the values are for 1 x 1 binning 

Column,Start,Length A comment 

347,2869,1 A single pixel event 

1959,2805,5 A short cluster along one column 

2552,0,4096 A full column defect 

3894,566,4 A short cluster along one column 

3895,568,2 An extension of the above cluster to a second column 

3896,569,1 A single pixel extension of the above cluster to a third column. 
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9 Appendix C 

 

User defined parameters can be added to the image file by using a text based file called 

“Other Parameters.txt” (see example box below).  This file can be created using a text 

editor or programmatically from a user program.  After an image is acquired, SI Image 

looks for the above file and adds any items found to the header of the image file.  The file 

is formatted like an “ini” type file with section names in square brackets.  Each section is 

an [Entry #] and each entry contains a Type, Keyword, Value, and Comment.  The 

Type can be String, Boolean or Numeric.  The Keyword follows the rules for a FITS file 

and can be up to 8 characters consisting of the numbers 0-9 and upper case letters A-Z.  

The Value will correspond to the Type.  For a String, the text should be enclosed in 

quotes.  A Boolean and be T or F.  A numeric will be read a floating point.  The 

Comment should also be enclosed in quotes. 

 

 

 [Entry 1] 

Type=String 

Keyword=LOCATE 

Value="Tucson, Arizona" 

Comment="Observation Location" 

[Entry 2] 

Type=Boolean 

Keyword=BLOCKED 

Value=T 

Comment="May be blocked" 

[Entry 3] 

Type=Numeric 

Keyword=POSITION 

Value=1234.5 

Comment="Camera Position" 

[Entry 4] 

Type=Numeric 

Keyword=TEMP 

Value=26.4 

Comment="Outside temperature" 


